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Chapter 1 About This Guide

Purpose
The purpose of this user guide is to aid you in learning to use the Trouble
Administration application. Both experienced and inexperienced users can use the
guide. New users may want to read the entire manual; experienced users may just
need to look up a specific functionality.

Regional Differences
Trouble Administration has slight differences in what is provided for states supported
by Southwestern Bell (SWB) and states supported by Pacific Bell (PB) and Nevada
Bell (NB). Differences will be noted by the corporate holding name for the region
(SWB, PB, and NB).

Organization
This user guide is divided into the following parts:

� Chapter 1 About this Guide
� Chapter 2 Introduction
� Chapter 3 Getting Started
� Appendix A TN Status Descriptions-LMOS
� Appendix B TN Trouble Cause Codes-LMOS
� Appendix C TN Trouble Disposition Codes-LMOS
� Appendix D Trouble Type Codes and Descriptions
� Appendix E Circuit ID Status Descriptions
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� Appendix F Circuit ID Log Functions

Chapter 1, About this Guide, tells you the purpose of this guide, details its
organization; discusses any special notes, warnings, or conventions.
Chapter 2, Introduction, discusses Trouble Administration and its installation
requirements, how to connect through Toolbar, what the system hours and
availability are, specific questions about Microsoft Windows®, and specific
procedures for accessing Trouble Administration’s online help.
Chapter 3, Getting Started, discusses Trouble Administration, logging on and
logging off, the Trouble Administration desktop and its menus and windows.

Conventions Used in the Guide
Icon, keyboard, field, window, tab, button, menu, and option names are in bold.
Steps in the task-based procedures are in bold and numbered. Screen prints related to
the step follow the step.
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Chapter 2 Introduction

Overview
Trouble Administration is an application that allows your company to handle trouble
reports via an on-line, graphical user interface that communicates directly to
Southwestern, Pacific, and Nevada Bell’s (SWB, PB, and NB, respectively) systems.
Trouble Administration provides the following functionality:

� Entry of a new trouble on a SWB/PB/NB circuit

� Entry of a new trouble on a SWB/PB/NB telephone number

� Status of an open trouble on a SWB/PB/NB telephone number

� Status of an open trouble on a SWB/PB/NB circuit

� Status of a closed trouble on a SWB circuit

� History on a SWB/PB/NB telephone number

� History on a SWB/PB/NB circuit

� Viewing a list of currently open troubles on SWB/PB/NB circuits and/or
telephone numbers

� Viewing a list of closed troubles on SWB/PB/NB circuits and/or
telephone numbers (limited by date range)

� Ability to initiate an MLT test on a SWB/PB/NB telephone number and
on a SWB telephone number-formatted circuits and views the results.
Also, ability to initiate an MLT test on an unbundled network element
(UNE) combination using the telephone number, or a UNE analog port
using the telephone number-formatted circuit ID.

� Loop enhancement: the ability to choose an MLT test type from full,
quick, loop, and central office on a SWB/PB/NB telephone number and a
SWB telephone number-formatted circuit.

� An inventory of all SWB circuits.

� Viewing binding post information on a PB/NB telephone number.

To use the application, you must have a Southwestern Bell Toolbar user ID with the
authority to access Trouble Administration. If you already have a Toolbar user ID,
you may need to have Trouble Administration access authority added.
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Installation Requirements

Software Requirements
Toolbar and its Trouble Administration application run in the Windows® 95™, or
Windows NT™ environment. Toolbar is accessible through dial-up or private line
connections. If you have installed a private-line connection to Southwestern Bell, you
will need to have a Transmission Control Protocol (TCP) stack on your PC. We
recommend Chameleon 4.x, Microsoft, or Windows 95/NT. Using a different TCP
stack may produce unreliable results.

Hardware Requirements
Computer: IBM PC compatible: 486 or greater
RAM: Win 95: 16 MB or higher / NT: 32 MB or higher
Hard Drive: 30 MB of available space or higher
Disk Drives: 3.5 inch high density / CD ROM drive
Monitor: VGA-compatible video driver
Modem: (Required for dial-up access)

14,400 bps minimum; 28,880 bps recommended
Mouse

Connecting to Trouble Administration
Access to Trouble Administration is through the Toolbar. Please see the Toolbar
user’s guide for connecting instructions.

System Availability and Support

Hours of Business

Trouble Admin Server Hours for All Users
Monday through Friday: 5:00 a.m. to 10:00 p.m. (local time)
Saturday & Sunday: 5:00 a.m. to 9:00 p.m. (local time)
Exception: POTS (plain old telephone service) history is available until 10:00 p.m.
(CST) and 8:00 p.m. (PST).

Help Desk

Competitive Local Exchange Carriers (CLECs)
The Information Services (IS) Call Center is your single point of contact for
assistance in answering questions and resolving issues such as expired passwords,
application and network problems, and installation and configuration of software.
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IS Call Center Hours for SBC CLECs:
(Note: off-shift hours covered by voice mail activated pager for emergencies.)
7:00 a.m. to 9:00 p.m. Central Time (CST) Monday through Friday
5:00 a.m. to 7:00 p.m. Pacific Time (PST) Monday through Friday
8:00 a.m. to 5:00 p.m. Central Time (CST) Saturday
6:00 a.m. to 3:00 p.m. Pacific Time (PST) Saturday
IS Call Center phone number for CLECs: 314-235-7225

All other Customers
Toolbar Customer Support is your single point of contact for assistance in answering
questions and resolving issues such as expired passwords, application and network
problems, and installation and configuration of software.

Toolbar Customer Support Hours for All Other Customers:
(Note: off-shift hours covered by voice mail activated pager for emergencies.)
6:00 a.m. to 10:00 p.m. Central Time (CST) Monday through Friday
4:00 a.m. to 8:00 p.m. Pacific Time (PST) Monday through Friday
Toolbar Customer Support Toll Free Number 800-262-6672
Toolbar Customer Support Toll Free Fax Number 800-698-0611

Questions about Microsoft Windows®

Windows is a graphical user interface (GUI), which means you can work with your
computer by clicking buttons and dragging icons. You can also understand how the
computer works by looking at its graphical display. This is better than remembering
command lines that you need to type in, as in Microsoft DOS™ applications.

Windows displays rectangular areas on the screen in a document or an application.
Because Trouble Administration works under the Windows environment, you can
switch back and forth between a Trouble Administration window and another
application’s window. Also, once you’ve learned how to work with menus and
buttons in one Windows application, you can use that knowledge in Trouble
Administration.

The Trouble Administration documentation assumes you have some familiarity with
Microsoft Windows™. The intention of the following tips is to cover a few basic
principles. Please see your Microsoft Windows™ user guide or online help for more
detailed instructions and documentation.

Using the Mouse
In Windows applications, you use your mouse to maneuver your pointer around the
application. You may use your mouse to:

Point Move the pointer to a specified place on your screen.
Click Press and release your mouse button.
Drag Hold down your mouse button, drag the mouse while holding the

button down then release the mouse button.
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Double-click Press and release your mouse button twice in rapid succession.

Your primary mouse button is the left button on your two-button mouse. If you are
left-handed, you may switch your buttons in your Windows Control Panel and move
your mouse to the left side of your workstation. Your mouse pointer displays
differently depending on where it is in your window.

The standard pointer displays as an arrow pointing up and slightly to the left.

 When you move your pointer close to the edge of a moveable window or
column, it changes to a two-headed arrow.

A blinking I-beam indicates that you have entered a text area, such as a field

in a window in Trouble Administration.

An hourglass denotes that the program is busy.

Using Keyboard Shortcuts
Every menu name or command in Windows contains keyboard shortcuts. You may
use the shortcuts by pressing the ALT key plus the underlined character of the menu
name or command at the same time. For example, you can activate the File menu by
pressing ALT+F.

Many of the menu options contain other keyboard shortcuts. Once the drop-down
menu has been activated, the keyboard shortcut is the underlined letter of each
option. For example, once you’ve activated the File menu, you may exit the Trouble
Administration application by pressing X. you may also use your directional arrows
(� and �) to move to the Exit option.

For additional shortcut key information, type “Keyboard Shortcuts” in your Windows
help Index.

Selecting Icons and Activating the Toolbar
Icons are graphical elements that represent an object that you can manipulate. Our
Toolbar contains an icon that allows you to access the Trouble Administration
application. You click icons to activate them.

The Toolbar desktop icon requires a double-click to activate. Once
activated, you log on to the Toolbar and from there, you have access to
the Trouble Administration application.
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The Trouble Administration icon on the Toolbar requires a single click to activate.
Clicking on the icon logs you on to the Trouble Administration application. You
must go through the Toolbar to get to this icon.

Note: The icons that will be available to you will depend upon which applications you have been assigned.

Accessing Online Help
There are three levels of online help in Trouble Administration:

� Help Menu
� Context Sensitive help
� Micro-level help

Help Menu and Button

The Help menu or button allows you to view general topics about Trouble
Administration, such as an overview of the system or the telephone number for the
Help Desk Support. It also provides an index that allows you to search for topics.
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Help Contents Page
When you open the help from the Help menu > Help Contents option, or click on
the Help Button, the help file displays the Table of Contents.

Clicking on a topic listed in the Contents page will display information about that
topic.
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Help Search Page
When you open the help from the Help > Context Sensitive Help option, or click on
the Search Button within the Help Contents page, the Help Topics: Trouble
Administration Help window is displayed. This window has two tabs available, the
Index and the Find tabs.

Index tab

In the section 1 field window, you can type in the first few letters of the word you are
looking for. As you type, Help will show matches in the section 2 window. When
you see a topic you want information on, you can click the topic to highlight it, then
click the Display button to show that topic.
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Find Tab - Building the Database
Trouble Administration Help allows you to perform a complete search using words
or phrases of the online help database using the Find tab. The first time that you
access the Find tab, you will be asked to allow the help database to be built. The
following steps indicate the process:

1. Click the Find tab. The Find Setup Wizard window opens.

The Minimize database size (recommended) listing is pre-chosen by default. This
is the most efficient type of build and you should keep it selected.
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2. Keeping the default settings, click the Next button. The Find Setup Wizard
will prompt you with the following window.
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3. Click the Finish button. The Help system will create the Find database and
display the Help Topics: Trouble Administration Help dialog box showing
the Find tab.

When you have completed these steps, you should be able to access Find without
having to rebuild the database again.
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Help Find Tab - After the Database is Built
Trouble Administration Help allows you to perform a complete search using words
or phrases of the online help database using the Find tab. The first time that you
access the Find tab, you will be asked to allow the help database to be built. This
instruction assumes you have already performed that process.

Note: To change the way help reacts to what you type into section 1, click the Options… button for additional
settings.
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1. In section 1, type the search word or phrase. As you type, section 2
displays the matches found on your word or phrase and section 3 displays
the topics for those matches.

2. Click on one of the matching words in section 2, and help will display
topics for that match in the section 3 window.

3. Click the topic in section 3 that you want to view, then click the Display
button. The selected topic is then displayed with the Help Topic window.
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Help Topic Window
After clicking the Display button, help will display a window showing information
about the topic that you chose. Within this window are buttons for navigating the
help system: Contents, Search, Back, Print and directional arrows.

When words are colored green and underscored with a solid line, clicking the word
will “jump” you to an explanation for that topic. When green words are underscored
with a dashed line, clicking the word will keep you where you are, but display a
message box defining the word or phrase. Click again to close the message box.

Contents
Clicking on the Contents button will display the Trouble Administration Help table
of contents page. Clicking on a topic listed in the Contents page will display
information about that topic.

Search
This button will return you to the Help Search window.

Back
If you have looked at more than one help topic, clicking on the Back button will take
you back to the topic you were previously viewing.

<< (Page), >> (Page)
The page buttons will take you one page forward or backward, within the help files,
for each time you click them. If you are at the first page of the help files, the previous
page button, <<, will be grayed out. This is true for the next page button, >>, if you
are on the last page.
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Help Contents Page
When you open the help from the Help menu > Help Contents option, or click on
the Help Button, the help file displays the Table of Contents.

Clicking on a topic listed in the Contents page will display information about that
topic.
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Micro-level Help
Each time you move your mouse pointer over a menu button, micro-help displays at
the bottom of your window. This micro-help is an expansion of the short
explanations you see displayed below the toolbar help buttons as the mouse rests over
them. For example, if your mouse pointer is resting over the Circuit Inventory
button, you will see Invoke Circuit Inventory Application displayed in the micro-
help area.

Context Sensitive Help
To access Trouble Administration’s Context Sensitive help, place your mouse pointer
in a field and press F1. Trouble Administration then displays the Help page that
includes a description for that field, its data characteristics, valid entries for that field,
one or more examples, and any notes that might be useful in entering your data.

Micro-Help
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Chapter 3 Getting Started

Toolbar

Software Distribution
After you have established an account with your Account Manager and requested
user IDs for the application, you will receive a CD or set of diskettes. You will use
these to install the Toolbar. Simply insert the first diskette or CD and select Run
from the Start button on your Taskbar. Type A:\setup (or substitute A with your CD
drive letter) and click OK. Follow the instructions of the on-screen prompts. This
will include specifying a directory on which to install the Toolbar and possibly
specifying a network user ID and password, if you have chosen a dial-up connection.

If you are accessing the Toolbar in dial-up mode, you will need to configure your
native dialer. We will provide dialer installation instructions with the Toolbar
installation package. After installing the Toolbar, the Toolbar icon displays on your
desktop. If you encounter any problems during the logon procedure, contact your
Support Center (see System Availability and Support, Chapter 2).

Logging on to the Toolbar

1. Locate the Toolbar icon on your PC desktop.
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2. Double-click the icon. The Toolbar Welcome dialog box opens.

3. Type your User ID and Password and click OK. The Toolbar opens. The
Toolbar connects you to our server. This server downloads the icons for
the applications you can access.

Note: Our Software Distributor automatically notifies you of new application releases through the Toolbar.
You must download the new release or you won’t be able to logon to Trouble Administration. The icons
that will be available to you will depend upon which applications you have been assigned.
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Logging off the Toolbar
1.  Click the Exit icon on the Toolbar.

Note: The icons that will be available to you will depend upon which applications you have been assigned.

Accessing Trouble Administration
The Toolbar provides a single point from which to launch Trouble Administration.
Once you’ve logged on to the Toolbar, you can access Trouble Administration.

Launching Trouble Administration

1. Click the Trouble Administration icon on the Toolbar.

Note: The icons that will be available to you will depend upon which applications you have been assigned.

2. The operating system launches the Trouble Administration application and
displays the main window of the application.

3. As soon as the main window launches, the CPNI (Customer Proprietary
Network Information) warning screen may display. If displayed, you must
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acknowledge the warning by clicking the OK button. You may then use the
application.

Note: This warning is only displayed for specific Trouble Administration users. You may not see this warning.
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Trouble Administration Application Idle Lock

1. If you’ve had the Trouble Administration application open but inactive for
more than 30 minutes, you’ll receive the Application Idle Lock dialog box.

2. You may click Logoff to exit the application or re-type your Toolbar
password and click OK to re-enter Trouble Administration. You will not be
able to re-enter Trouble Administration until you re-enter your password.

Exiting Trouble Administration
1. From the File menu, choose Exit.
2. The Trouble Administration application prompts you with the following

message. Click Yes or press Enter.

Note: You will only be prompted if the Prompt On Exit option is checked in the Options menu.
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Trouble Administration Desktop
The Trouble Administration desktop consists of these main sections.

Menus The pull-down menus allow you to open and print windows,
and perform various desktop functions.

Toolbar Buttons The toolbar is the row of buttons that act as a shortcut to the
more often used commands available in the menus.

Function Windows These are the windows where you can perform various
functions such as Circuit Inventory Search, Mechanized
Loop Test, Trouble Ticket Status and Ticket Search, Report

Trouble and
others.

Menus
At the top of the Trouble Administration desktop are the pull-down menus File, Edit,
Inventory, Test, Trouble, Binding Post, Options, Window, and Help. These
menus allow you to open and print the different Trouble Administration windows and
perform various other desktop functions.

Menu Bar

Toolbar

Micro-level Help



Trouble Administration
                                                                                                                    User Guide

                                                                                                                                                                                                      
Proprietary - Not for use or disclosure outside of the SBC Family of Companies except by prior written agreement. Competitive Local Exchange Carriers
(CLECs) may use, reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities of this Southwestern
Bell Telephone Company, Pacific Bell, or Nevada Bell Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and Southwestern Bell Telephone Company, Pacific Bell, or Nevada Bell. Additional or external use is strictly prohibited.
© Copyright 1998, 1999. Southwestern Bell Telephone Company. ALL RIGHTS RESERVED.

 3-7

File menu options

Close
Clicking on this option will close any active window. If no function windows are
open, this option will close the Trouble Administration application itself.

Save As…
The Save As… option will allow you to save information from a function window to
another file. Not all of the function windows have the Save As... option available.
When not available, the option will be grayed out.

The Save As… option is available for these windows:

Open Trouble Tickets: Circuit History
Closed Trouble Tickets: Telephone Number History
Circuit Inventory Search Results: MLT List
Circuit Legs: MLT Results

With an appropriate window open, click on the Save As… option. The Save As
dialog box will display.
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File Name
When the dialog box first opens, the File Name field is already highlighted. You may
begin typing in the name you want your file to have. You do not have to type in the
three-letter extension; the dialog box will add the appropriate extension from your
choice in the File Format panel.

Save in & Browse
The default directory where the file will be saved is shown next to the Save in listing.
If you do not want to save the file to the default directory, you may click the Browse
button and build the path to where you want it saved.

File Format
Within this panel are listed the available file formats that you can save to. To choose
a format, click the radio button in front of your choice. If you are unfamiliar with file
formats, keep the default Text format. Most programs can import from Text.

Click the OK button to save your file, or the Cancel button to close the dialog box
and return to the Trouble Administration desktop.
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Print…
This option is available for all windows within the Trouble Administration
application. For most windows, clicking this option will launch the Print Options
dialog box, from which you can then print a document based on the window you
have active. The Dialog box allows you to select document printing options and
different printer if you wish to print to one other than your default printer.
If the ‘Print Options’ window does not open when you select the Print button, the
image of the current window is printed to your default printer.

Note: You can change the default printer using the File > Printer Setup… option.

Printer Setup…
This command launches a Printer Selection window. If you have more than one
printer available, you may click on a printer to highlight the one you want Trouble
Administration to print to. Once you have selected a printer you may click OK to
return to Trouble Administration, or click the Setup… button to access the
configuration settings for the printer you highlighted. Clicking the Close button will
close the Printer Setup window and return you to Trouble Administration without
making any changes to your printer.

Exit
You may click on this option to exit the Trouble Administration application.

Note: When a menu command is not available, the command will be grayed out on the menu list.
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Edit menu options

 

Cut
This option is available when the cursor is within user editable data fields (e.g.
telephone number or circuit ID, etc.). When at least one character has been
highlighted, clicking on this option removes the selected text from its original
location so that it can be pasted elsewhere in Trouble Administration or other
Windows applications.

Copy
This option is available any time you have highlighted text within a user editable
field, or when you have selected text from a list or report. With a selection
highlighted, clicking on this option will copy the selected text without altering its
original location so that it can be duplicated (pasted) elsewhere in Trouble
Administration or any other Windows application.

Paste
This option is available when the cursor is within user editable data fields within a
Trouble Administration window. Clicking on this option will place text that has been
copied or cut. The text will place at the current point of the editing cursor including
overwriting entire highlighted selections.
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Inventory menu options

Circuit Inventory
Clicking on this option will launch the Circuit Inventory Search window. The Circuit
Inventory Search window gives you four options to search by: serial number, trunk
group access code, telephone number and circuit ID. This option is available only in
the Southwestern Bell region.

Test menu options

Initiate MLT
Clicking on this option will display the Mechanized Loop Test window. This window
provides you the ability to perform a Loop test on the telephone number or telephone
number formatted circuit you designate.

Trouble menu options
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View History
This option launches the View History window. The window allows you to perform a
search by either telephone number (SWB/PB/NB) or circuit ID (SWB only) and view
the history for the result.

Trouble Ticket Status and Ticket Search
Clicking this option will open a search window for retrieving circuit (CKT) status,
telephone number (TN) status, all open and closed troubles, open and closed TN
troubles, and open and closed CKT troubles.

Report Trouble
By clicking this option the Report Trouble window will display. From the Report
Trouble window you can launch either the circuit ID trouble report window or the
telephone number trouble report window by filling in the appropriate number or ID.

Binding Post menu options

Initiate Binding Post
Clicking this option will open a search window to retrieve binding post information
for the telephone number entered (PB/NB only).

Options menu options
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Change Password
This option is permanently grayed out. This function now takes place within the
Southwestern Bell Toolbar application.

Prompt on Exit
The Prompt on Exit option allows you to choose whether or not you want a warning
message to display prior to actually exiting Trouble Administration. This is useful to
prevent exiting when the exit button is clicked by mistake. Click on the menu item to
turn this option on or off. A check mark indicates that it is on.

Show Text
Clicking this option toggles the text, displayed on the toolbar buttons, on or off. Click
on the listing to turn this option on or off. A check mark indicates that it is on.

Window menu options

Tile
Clicking this option arranges all of the open windows within Trouble Administration,
vertically, one next to the other. The window that is active when you invoke this
command will be the left most window.

Layer
Clicking this option arranges all of the open windows within Trouble Administration,
one on top of the other. Windows are “overlaid” full height and width. The window
that is active when you invoke this command will be the top window.

Cascade
Clicking this option arranges all of the open windows within Trouble Administration,
one on top of the other, in “waterfall” fashion. The window active at the time the
Cascade command is selected appears on top.
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Arrange Icons
Clicking this option arranges any minimized Trouble Administration windows in
order.

List Panel
This bottom panel on the Window Menu is dynamic. The panel will list any window
you have open within Trouble Administration. A check mark appears next to the
listed window that is active. You can change to and view any window in this list by
clicking on it.

Help menu options

Trouble Administration Help Contents

This option displays the Trouble Administration On-line Help files, opening to the
Table of Contents. For further information about On-line Help see section 2,
Accessing On-line Help.

Context Sensitive Help
To access Trouble Administration’s Context Sensitive help, place your mouse pointer
in a field and press F1. Trouble Administration then displays the Help page that
includes a description for that field, its data characteristics, valid entries for that field,
one or more examples, and any notes that might be useful in entering your data.

Help Topics
This option displays the Trouble Administration On-line Help files, opening to the
help Search page. For further information about On-line Help see section 2,
Accessing On-line Help.

About Trouble Administration
The About option displays the Trouble Administration version and copyright
window. The Help Desk may ask you for the for the version number when you call.
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Trouble Administration Toolbar
The toolbar is the row of buttons below the menu bar. The buttons act as a shortcut to
the more often used commands available in the menus. As is the case with specific
menu commands, Toolbar buttons are not always functional. Some will only be
available when a particular window is active.

Circuit Inventory
Clicking on this option will launch the Circuit Inventory Search window. The Circuit
Inventory Search window gives you four options to search by: serial number, trunk
group access code, telephone number and circuit ID. This option is available only in
the Southwestern Bell Region.

 Initiate MLT
Clicking on this button will display the Mechanized Loop Test window. This window
provides you the ability to perform a loop test on the POTS telephone number or the
Unbundled Network Element (UNE) analog port.

 View History
This button launches the View History window. The window allows you to perform a
search by either telephone number or circuit ID and view the history for the result.

 Trouble Ticket Status and Ticket Search
Clicking this button will open a search window for retrieving circuit (CKT) status,
telephone number (TN) status, all open and closed troubles, open and closed TN
troubles, and open and closed CKT troubles.
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 Trouble Report
By clicking this option the Report Trouble window will display. From the Report
Trouble window you can launch either the circuit ID trouble report window or the
telephone number trouble report window by filling in the appropriate number or ID.

 Binding Post
Clicking this option will display the Binding Post window. From this window you
can retrieve binding post information for the telephone number that was entered
(PB/NB only).

 Save As
The Save As… option will allow you to save information from a function window to
another file. Not all of the function windows have the Save As... option available.
When not available, the option will be grayed out.

 Print
This option is available for all windows within the Trouble Administration
application. For most windows, clicking this option will launch the Print Options
dialog box, from which you can then print a document based on the window you
have active. The Dialog box allows you to select document printing options and
different printer if you wish to print to one other than your default printer.
If the ‘Print Options’ window does not open when you select the Print button, the
image of the current window is printed to your default printer.

Note: You can change the default printer using the File > Printer Setup… option.

 Help
This option displays the Trouble Administration On-line Help files, opening to the
help Contents page. For further information about On-line Help see section 2,
Accessing On-line Help.
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 Exit
You may click on this option to exit the Trouble Administration application.

Trouble Administration Windows
Trouble Administration has a variety of function windows, allowing you to perform
actions such as searches, see details, observe histories, initiate tests and invoke
trouble reports. Many of these function windows will produce result windows based
on the criteria you have defined. In addition, some of these windows provide
shortcuts to the other windows to help expedite your tasks.

Circuit Inventory Search Window:
� Circuit Inventory Search Results Window
� Circuit Leg Window

Mechanized Loop Test Window:
� Mechanized Loop Test Result Window

History Search Window:
� Telephone Number History Window
� Telephone Number History Detail Window
� Narrative Line Description Window
� Circuit History Window

Trouble Ticket Status and Ticket Search Window:
� Circuit Trouble Status Window
� Telephone Number Trouble Status Window

Trouble Report Window:
� Circuit Trouble Report Window
� Telephone Number Trouble Report Window

Open Trouble Summary Window:
� Closed Trouble Summary Window
� Trouble Description Window

Binding Post Window:
� Binding Post Results Window

This section of the User Guide will explain these windows and the subsequent
resulting windows that can be derived from each.
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Circuit Inventory Search
This option is only available in the Southwestern Bell region.

The Circuit Inventory Search window can be displayed by clicking on the Circuit
Inventory icon from the Trouble Administration toolbar or by clicking on the Circuit
Inventory listing within the Inventory menu.

The Circuit Inventory Search window allows you to input a serial number, trunk
group access code (TGAC), telephone number or a partial circuit ID to search the
circuit database, resulting in the return of a list of matching circuits displayed within
the Circuit Inventory Search Results window.

Serial Number
This search allows you to input a six-digit serial number. Click in the field
window and type in the number.

2 – 6 Code (TGAC)
This search allows you to input the Trunk Group Access Code (TGAC), which is
also known as the 2 - 6 code. This field will accept two alpha characters followed by
six numbers. When you click on the Search button, it will return a list of all the
interoffice message trunks that match the 2 - 6 code.

Telephone Number
This search has three input areas: NPA, NXX and Line Number, where NPA is three
numeric characters, NXX is three numeric characters and Line Number is four
numeric characters. Click in the field windows and type in the numbers.
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Circuit ID
This search allows you to input a partial or complete circuit ID. The circuit database
is then searched by the Trouble Administration application for circuit IDs that match
your input, starting from the first position. You must input at least one character.

Clear
Click this button to remove all of your entries from the fields.

Search
After you have entered the information you want to search by, click on the Search
button. If the number of matching circuits is too many to display, you will receive an
error message. Click the OK button, then try supplying more information in your
search criteria and initiate your search again.

When your search is successful, the Circuit Inventory Search Results window will
display.

Circuit Inventory Search Results window
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The Circuit Inventory Search Results window displays a listing of all the circuits or
message trunks found as a result of the parameters you defined in the Circuit
Inventory Search window. Click on a circuit ID or message trunk to highlight it, then
choose one of the action buttons to the right. Four buttons are available, the Report
Trouble, View History, Circuit Legs and MLT. The characteristics of the
highlighted circuit ID determine the availability of these buttons.

Report Trouble
If the circuit ID or message trunk you have highlighted is an independent circuit, (one
that does NOT have multiple legs), clicking the Report Trouble button will display
the Report Trouble window pre-filled with information on that circuit or trunk.

If the circuit ID you have highlighted is a parent circuit, (one that has multiple legs),
clicking the Report Trouble button will display the Circuit Legs window, listing all
the legs for the parent circuit. From the Circuit Legs window you can choose a
particular leg to either report trouble on or view history on.

View History
Clicking on the View History button will display the Circuit History window for
the circuit or message trunk you had highlighted. From the Circuit History window
you can view the status of any trouble tickets displayed.

If there are no trouble tickets for the highlighted circuit in the Circuit Inventory
Search Result window, clicking the View History button will display a
TRBLADMN – Information message box. Click OK on the message box to return
to the Circuit Inventory Search Result window.

Note: If you have highlighted a parent circuit, and clicked the view History button, Trouble Administration will
display the TRBLADMN – Information message box even if one of the parent’s circuit legs has a trouble
ticket in history. You must perform the View History function on the circuit leg itself.

Circuit Legs
Clicking on this button will display the Circuit Legs window for the highlighted
circuit. From the Circuit Legs window you can report trouble or view history for any
of the legs displayed. If the highlighted circuit in the Search results window is not a
parent circuit, a TRBLADMN – Information message box will display after
clicking the Circuit Legs button. Click OK on the message box to return to the
Circuit Inventory Search Result window. In addition, the Circuit Legs button will be
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grayed out whenever that circuit is highlighted during this same session of the Circuit
Inventory Search results window.

MLT
Click this button to launch the Mechanized Loop Test window pre-filled with the
information on the circuit you highlighted from the Search results window. MLT is
only available to test UNE combination or standalone UNE analog ports that carry a
circuit ID.

Circuit Inventory Search Results window (Invoked from a Ckt Search button)

The available buttons within the Circuit Inventory Search Results window are
different when the window has been invoked as a result of clicking the Ckt Search
button in the Report Trouble, MLT or History Search windows, and then clicking the
Search button in the Circuit Inventory Search window. The Select and Close buttons
are the only ones available in this case.
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Select
Clicking this button will invoke one of two responses depending on if the circuit you
highlight is a parent circuit or an independent circuit.

If the circuit ID you have highlighted is an independent circuit, (one that does NOT
have multiple legs), clicking the Select button will display the Report Trouble
window pre-filled with information on that circuit, or the Circuit History window,
depending from which window you are working from.

If the circuit ID you have highlighted is a parent circuit, (one that has multiple legs),
clicking the Select button will display the Circuit Legs window, listing all the legs
for the parent circuit. From the Circuit Legs window you can choose a particular leg
to using that window’s Select button.

Close
Clicking on this button will close the Circuit Inventory Search Results window and
return you to the Circuit Inventory Search window as invoked from the Ckt Search
button.

Circuit Legs window

The Circuit Legs window is displayed when you click on the Circuit Legs button in
the Circuit Inventory Search Results window. The Circuit Legs window is also
displayed if you click the Report Trouble button on the Circuit Inventory Search
Results window and the circuit selected is a multi-point circuit. This option is not
available in the Pacific Bell / Nevada Bell region.

The Circuit Legs window displays the circuit legs for the selected circuit. From this
window you can Report Trouble or View History on the circuit legs.
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Columns in the Display
By positioning the mouse over one of the two-divider lines that define a column the
resize cursor will display,  . To change the column width hold down the mouse
button and drag the line until the desired column width is achieved.

The entire MLT list can be sorted by in any column in ascending or descending
order. The default sort order is by telephone number, smallest number to largest
number. To change the sort, move the mouse over a column heading until the 
cursor displays. Click the mouse to sort by that column. Click the mouse again to
toggle between an ascending or descending sort order.

Report Trouble
Clicking the Report Trouble button will display the Report Trouble window pre-
filled with information on the circuit leg you have highlighted.

Trouble Administration will not allow you to report trouble on a circuit that has an
existing trouble report. However, you will be provided the option to view status of
the open trouble report.

View History
Clicking on the View History button will display the Circuit History window for
the circuit you have highlighted. From the Circuit History window you can view the
status of any trouble tickets displayed. This option is not available in the Pacific Bell/
Nevada Bell region.

If there are no trouble tickets for the highlighted circuit in the Circuit Legs window,
clicking the View History button will display a TRBLADMN – Information
message box. Click OK on the message box to return to the Circuit Legs window.
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Circuit Legs window (Invoked from a Ckt Search button)

The available buttons within the Circuit Legs window are different when the window
has displayed as a result of clicking the Select button in the Circuit Inventory Search
window, when a parent Circuit was highlighted. The Select and Close buttons are the
only ones available in this case. This option is not available in the Pacific Bell /
Nevada Bell region.

Select
Clicking the Select button will display the Report Trouble window pre-filled with
information on that circuit, or the History Search window, depending on which
window you were working from.

Close
Clicking on this button will close the Circuit Legs window and return you to the
Circuit Inventory Search Results window as invoked from the Ckt Search button.

History Search window
The History Search window is accessed by clicking the History button from the
Trouble toolbar, or selecting the Trouble > View History menu option.

Within this window you may enter a telephone number or a circuit ID and perform a
Trouble History Search on your input.
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Telephone Number
This search has three input areas: NPA, NXX and Number, where NPA is three
numeric characters, NXX is three numeric characters and Number is four numeric
characters. Click in the field windows and type in the numbers. When you are
finished typing, click the View History button and a warning message window will
be displayed.

 Click the Yes button to display the Telephone Number History window with the
telephone number indicated. Click the No button to cancel the transaction.

Circuit ID
This search allows you to input a partial or complete circuit ID.

If you know the complete circuit ID, type it into the field window and click the View
History button.

If you only know a partial circuit ID, then type in as much as you know and click the
Ckt Search button. This will launch the Circuit Inventory Search window pre-filled
with the partial circuit ID you entered. From there you can further refine your search,
eventually returning to the History Search window pre-filled with a complete circuit
ID. This option is not available in the Pacific Bell / Nevada Bell region.

Clear
Click this button to remove all of your entries from the fields.

View History
Clicking the View History button with a telephone number indicated will display the
Telephone Number History window.

Clicking on the View History button after indicating a circuit ID, will display the
Circuit History window for the circuit ID you have defined. From the Circuit
History window you can view the status of any trouble tickets displayed, except in
the Pacific Bell / Nevada Bell region.

If there are no trouble tickets for the circuit ID indicated, then clicking the View
History button will display a TRBLADMN – Information message box. Click OK
on the message box to return to the History Search window.
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Telephone Number History window
This window is accessed by clicking the View History button from the History
Search window or the Closed Trouble Records window.

This window allows you to view the latest history of trouble tickets on a telephone
number. If no trouble tickets exist for the telephone number you indicated in the
History Search window, this window will still display but the rows will be blank.

View Detail
By clicking the View Detail button, you can display the Telephone Number History
Detail window for the selected ticket (row).
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Telephone Number History Detail window

Whenever there is a charge associated with a trouble report, the narrative line
displays a “Z (space)” followed by codes rather than a description. If that is the case,
a More Narrative Info... button is displayed on the screen.

More Narrative Info…
Clicking this button will display the Narrative Line Description window that explains
the codes displayed on the Narrative line.

Narrative Line Description window
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The Narrative Line Description window explains the codes that may be displayed
within the Telephone Number History Detail window. If you want to print the
information within this window you will need to access it through the Trouble
Administration Help and print it from there.

Printing the Description window
1. Go to the Help menu and click on the Help Index option.
2. When the Help window displays, scroll down until you see the listing titled,

Narrative Line Description Window.
3. Click the Narrative Line Description Window listing to display it.
4. From the File menu, click the Print Topics option.
5. The Help topic will print to your default printer.
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Circuit History window
This window is accessed by clicking the View History button from the History
Search window or the Closed Trouble Records window.

This is a list of all closed trouble reports for the circuit that you indicated in the
History Search window. This option is not available in the Pacific Bell / Nevada Bell
region.

Columns in the Display
By positioning the mouse over one of the two-divider lines that define a column the
resize cursor will display,  . To change the column width hold down the mouse
button and drag the line until the desired column width is achieved.

The entire Circuit History list can be sorted by any column in ascending or
descending order. To change the sort, move the mouse over a column heading until

the  cursor displays. Click the mouse to sort by that column. Click the mouse
again to toggle between an ascending or descending sort order.

View Status
Click on a ticket (or row) to select it, then by clicking the View Status button, you
can view the status and log information for the trouble ticket.
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Circuit Trouble Status window
This window is accessed by clicking the View Status button within the Circuit
History window, or when you have entered a circuit’s trouble ticket number in the
Trouble Ticket Status and Ticket Search window and clicked the Retrieve button.
This window will also display if you have double-clicked an entry from one of the
Trouble Ticket List windows.

The title bar displays the number for the trouble ticket. This window displays the
status messages and log messages for the trouble ticket. You may scroll the Trouble
Log entries to see any that may be listed below the window. This window and its
information may be printed or saved to a file.

Get Report
You can view the original trouble report that prompted the investigation of this
circuit by clicking the Get Report button.

Refresh
It is possible that an update to the status of the trouble ticket could occur after you
first opened it. Clicking the Refresh button will update the status if this has
happened.
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Retrieved At
This message field, along the bottom of the window, indicates when this data was
retrieved from the Trouble Administration server. This message updates when you
click the Refresh button.

Mechanized Loop Test window
This window may be accessed by clicking the MLT Test button on the Trouble
Administration toolbar or clicking the Initiate MLT option from the Test menu.

This window will allow you to initiate a Mechanized Loop Test for a 10-digit
telephone number or a circuit ID1. You may initiate tests for several numbers during
a session. The MLT list is updated each time a test is initiated and lists all of the tests
you have initiated during this session of Trouble Administration.

Note: Mechanized Loop Test is available only on POTS services, the combination of an analog switch port and
an 8db analog loop when combined by SWB/PB/NB, and for UNE analog ports.

Telephone Number
This field has three input areas: NPA, NXX and Number, where NPA is three
numeric characters, NXX is three numeric characters and Number is four numeric
characters. Click in the field windows and type in the numbers. When you are
finished typing, you may choose a test type then click the Initiate MLT button to
start the test. This field is used for POTS services and the combination of an analog
switch port and an 8db analog loop when combined by SWB/PB/NB. After clicking
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the Initiate MLT button, a warning message window will be displayed if your
company profile indicates that the TN entered is not part of your company profile.

Click the No button to cancel the transaction.

Circuit ID
This field is available for initiating an MLT on a UNE analog port using the TN
formatted circuit ID or on ADSL Lineshare which requires a serial circuit ID1. If you
do not know the full circuit ID, you can type in as much as you do know and click the
Ckt Search button. This option is not available for Pacific Bell / Nevada Bell
accounts.
   1    MLT test on TN Formatted Circuit ID is only available for SWB accounts.

     MLT on ADSL Lineshare circuits in SWBT may be requested using a circuit ID:

MLT may be requested using a circuit ID with a serial code and modifier of UAFU.
The circuit ID must include a segment and be in an acceptable format:

Example 12.UAFU.123456.123.PT

If the user provides a circuit ID that is incomplete or inaccurate, the match cannot be
completed and the user will receive a message "circuit not found".

An mlt can only be initiated where the dial tone portion of the circuit belongs to the
DLEC and is not ported out.

If the dial tone is ported out, the user will receive a message "this TN has been
disconnected or ported out. No information available."

With linesharing, the DLEC will only be allowed to do MLT on the dial tone portion
of the line if they are the owners of record on the circuit associated with the dial
tone.

If ownership cannot be validated, the user will receive a message "unauthorized to
access this information."

Using the TN to MLT with lineshare will only be allowed if the requestor is the
owner of record of the dial tone portion of the line.

If ownership cannot be validated, the user will receive a message "unauthorized to
access this information."
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MLT Test type
There are four different types of MLT tests that can be requested: Central Office,
Full, Loop and Quick. The Full test returns the most information with the other tests
returning different subsets of what a Full test would provide. Click the drop-down
arrow to see the list of available tests, then click on the test type you want to initiate.
If you do not indicate differently, a Full type test is performed.

Note: If you want to initiate different test types for the same number, you must wait at least 1 minute between
each test to avoid the results duplicating the previous type initiated.

Initiate MLT
After you have typed in a telephone number, you may click the Initiate MLT button
to start the Loop test. An MLT test will typically take from 45 seconds to 2 minutes
to complete. When an MLT is initiated, the results are populated in the main window
of the Mechanized Loop Test dialog box. The system automatically refreshes these
results every 45 seconds, hence it is not necessary to use the Refresh button to
retrieve results. Looking at the “Completed At” column will tell you if the MLT is in
process or if its completed. If it is completed, there will be a time and date stamp in
place of the words “In Process...” You should not reinitiate an MLT on the same
number until at least two minutes has elapsed with no results. This will help to avoid
a backlog of requests within the system.

Clear
Clicking on this button will clear any information you have typed into the field
windows. This is useful for entering several numbers to test in one session.

Ckt Search
If you do not know the complete circuit ID that you want to initiate a test on, type in
as much as you do know and click the Ckt Search button. The Circuit Search
window will launch, pre-filled with the partial ID you entered. From the subsequent
Search Results window, you can select one of the circuits listed and you’ll be
returned to the Mechanized Loop test window where you can initiate the test. This
option is not available in the Pacific Bell / Nevada Bell region.

MLT List display
The MLT list is updated each time a test is initiated and lists all of the tests you have
initiated during this session of Trouble Administration.

Columns in the display
By positioning the mouse over one of the two-divider lines that define a column the
resize cursor will display,  . To change the column width hold down the mouse
button and drag the line until the desired column width is achieved.

The entire MLT list may be sorted by in any column in ascending or descending
order.
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To change the sort, move the mouse over a column heading until the  cursor
displays. Click the mouse to sort by that column. Click the mouse again to toggle
between an ascending or descending sort order.

Telephone #
This column lists the telephone number or circuit ID that you initiated a test on.

Requested At
The time that you clicked the Initiate MLT button is reflected in this column.

Completed At
This column displays the time that a Loop test was completed. This field will update
in two ways. If you initiate another MLT test, that action will refresh the window and
if any previous initiated tests have completed, the completion time will display. If the
test has completed, this field will populate at that time.

Viewed
The viewed column indicates whether you have retrieved the results for a particular
MLT test.

Retrieved At field message
This area indicates the last time the MLT List display was refreshed or updated.

MLT Result
After the Completed At column is populated, you can view the selected test results
by double-clicking on the selected test or by highlighting a test and clicking the MLT
Result button. If you try to exit Trouble Administration before viewing an MLT test
result, the system will prompt you to confirm that you do want to exit before viewing
the results.

Test results will remain available until you log off the Trouble Administration
application.

Initiating Multiple Tests
In some instances you may have multiple numbers to test. The following steps
describe an efficient way to do this.
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1. Enter the telephone number or circuit ID and then click the Initiate MLT
button.

2. Click the Clear button to clear out the entry fields.

3. Type in the next telephone number or circuit ID, then click the Initiate MLT
button.

The MLT list is updated each time a test is initiated and lists all of the tests you have
initiated during this session of Trouble Administration.

Mechanized Loop Test Results window
This window is displayed as a result of clicking the MLT Result button on the
Mechanized Loop Test window. This window may be saved to a file or printed.

This example window displays the details of a Full MLT test for the selected
telephone number as follows:

� Verification Code (Ver Code: 41).

� Telephone number that was tested (Service: 3142352366).

� The type of test you chose to initiate (TEST TYPE: FULL).

� A word summary of the test results (Summary: OPEN OUT BALANCED
…)
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� DC Signatures for MLT with Tip to Ring (T-R), Tip to Ground (T-G)
and Ring to Ground (R-G) readings. It will also display any foreign
voltages detected.

� AC Signature with Tip to Ring (T-R), Tip to Ground (T-G) and Ring to
Ground (R-G) readings. If ringers are detected, this will be indicated by
the word “YES” next to the T-R reading.

� The Central Office test, displaying the results of a line check (LINE
CKT OK) and dial tone check (DIAL TONE OK).

� Capacitance tests (CAP 100%) are performed and if possible will
calculate the estimated loop length (LOOP LENGTH = 2200 FT) of the
total facilities connected to the office equipment.

Trouble Ticket Status and Ticket Search window
You may access this window by clicking the Search button from the Trouble
Administration toolbar or clicking the Trouble Ticket Status and Ticket Search
option from the Trouble menu.



Trouble Administration
                                                                                                                    User Guide

                                                                                                                                                                                                      
Proprietary - Not for use or disclosure outside of the SBC Family of Companies except by prior written agreement. Competitive Local Exchange Carriers
(CLECs) may use, reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities of this Southwestern
Bell Telephone Company, Pacific Bell, or Nevada Bell Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and Southwestern Bell Telephone Company, Pacific Bell, or Nevada Bell. Additional or external use is strictly prohibited.
© Copyright 1998, 1999. Southwestern Bell Telephone Company. ALL RIGHTS RESERVED.

 3-37

This window may be used to retrieve trouble ticket status for circuits and telephone
numbers. They may be retrieved by a variety of parameters including open or closed
status, telephone number, circuit ID, trouble ticket number, date range and reported
by. The originating trouble ticket itself can be retrieved from the subsequent windows
that are displayed as results from this window.

Retrieve Trouble Ticket Status
This option is designed for retrieving a single trouble ticket’s status when you know
the ticket number. Click in the Ticket Number field window to activate this option.
Type in the number for the trouble ticket you would like to inquire about. Click the
Retrieve button and a warning window will come out.

If the Yes button is clicked, the Telephone Number Trouble Status or the Circuit
Trouble Status window will display, depending on whether you entered a trouble
ticket for a telephone number or a circuit. If the No button is clicked, the transaction
will be cancelled. From the Trouble Status window you may also retrieve the
originating trouble ticket. No other information has to be filled out when performing
a search using this option.

Retrieve Trouble Tickets
With this option you may retrieve status on multiple trouble tickets using the
parameters provided in the panel. Additionally, if you don’t know a ticket’s number,
you can find a single ticket using some of the parameters that you do know to narrow
down a search. In the Pacific Bell / Nevada Bell region, this section will only work
for tickets issued from Trouble Administration.

Trouble Ticket Type
Use this field to indicate whether you are searching for open or closed tickets. This is
a required entry when using the Retrieve Trouble Tickets option on this window.

Date Range
To indicate the start of a date range, click the up or down arrow at the end of the first
field window. This will cause today’s date to display. Click your mouse in the day,
month or year section that you want to change. You may then click the up or the
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down arrow to edit that section up or down. When you are finished with the starting
date, perform the same function in the second field window for the ending date.

There may be range limits or implied defaults, depending on whether your search is
for open or closed tickets:

For Open Ticket Searches
You may enter a specific date range, or leave it blank. No default range is implied,
and there are no limits on the range you indicate.

For Closed Ticket Searches
You may enter a specific date range or leave it blank, but if you leave it blank, the
system defaults it to a range of 7 days prior to the current day. (This range can be
customized smaller for your company if requested). If you do enter a date range, you
are limited to a range not greater than the number of days your company is
configured for.

For example: if the company-customized maximum range is 5 days, a date range of
01/01/2000 through 01/05/2000 could be specified. If you specify 01/01/2000
through 01/10/2000 you will receive an error message stating that the date range
entered exceeds the maximum date range. This example holds true for the default
seven-day maximum as well.

Note: If you choose the Only a Specific Telephone Number or Only a Specific Circuit Number entry from
the Search By field, the date range maximum and implied default are not enforced.

    Reported By
Click the drop-down arrow do see a list of reporters within your company.
You may pick a reporter name by clicking on it. This is not a required field.
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Search For
The Search For options allow you to further refine your search. This is a required
entry when using the Retrieve Trouble Tickets option on this window. To choose an
option, click on the radio button in front of the entry you would like to use. You may
choose only one entry per search.

Both Telephone Numbers and Circuits
This entry will provide a list that includes both telephone number and circuit trouble
tickets. The list will be made up of either closed or open tickets depending on the
option you choose for the Trouble Ticket Type field.

Only Telephone Numbers
Selecting this entry will provide a list of only Telephone Number trouble tickets. The
list will be made up of either closed or open tickets depending on the option you
choose for the Trouble Ticket Type field.

Only Circuits
Selecting this entry will provide a list of only circuit trouble tickets. The list will be
made up of either closed or open tickets depending on the option you choose for the
Trouble Ticket Type field.

Only a Specific Telephone Number
This field has three input areas: NPA, NXX and Number, where NPA is three
numeric characters, NXX is three numeric characters and Number is four numeric
characters. Click in the field windows and type in the numbers. If no date range is
specified, this entry will provide a list of either all the closed or all the open
(depending on the option you choose for the Trouble Ticket Type field) trouble
tickets on this specific telephone number.

Only a Specific Circuit
Click in the field window and type in the complete circuit ID. If no date range is
specified, this entry will provide a list of either all the closed or all the open
(depending on the option you choose for the Trouble Ticket Type field) trouble
tickets on this specific circuit ID. If you do not know the complete circuit ID, you
may click the Ckt Search button to find the circuit you are looking for.

Retrieve
After you have indicated your search parameters from either the Retrieve Trouble
Ticket Status panel or the Retrieve Trouble Tickets panel, you may click on the
Retrieve button to invoke your search. Depending on the type of search you
indicated, one of several result windows will display.
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Clear
Clicking on this button will remove all inputs you have made to the Trouble Ticket
Status and Ticket Search window.

Telephone Number Trouble Status window
This window displays when you have entered a telephone number’s trouble ticket
number in the Trouble Ticket Status and Ticket Search window and clicked the
Retrieve button. This window will also display if you have double-clicked an entry
from one of the Trouble Ticket List windows using the View Status button.

This window displays the current status messages for the trouble ticket.

Get Report
You can view the original trouble report that prompted the investigation of this
telephone number by clicking the Get Report button.

Refresh
It is possible that an update to the status of the trouble ticket could occur after you
first opened it. Clicking the Refresh button will update the status if this has
happened.

Open Trouble Records window
This window is displayed by clicking the Retrieve button on the Trouble Search
window after choosing Open in the Type field. This list can also be limited to just
telephone number trouble tickets or just circuit trouble tickets or both by the option
you choose in the Search For section of the Trouble Search window.
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The title bar of this window indicates the Type and Search By parameters you
selected in the Trouble Search window. This particular window is displaying a list of
all open trouble reports for the company, based on the search criteria provided in the
Trouble Ticket Status and Ticket Search window. The current status of a listed
trouble report is indicated in the Status column. See Appendix A for translations of
the status codes.

Columns in the Display
By positioning the mouse over one of the two-divider lines that define a column the
resize cursor will display,  . To change the column width hold down the mouse
button and drag the line until the desired column width is achieved.

The entire Open Trouble Records list can be sorted by in any column in ascending or
descending order. To change the sort, move the mouse over a column heading until
the  cursor displays. Click the mouse to sort by that column. Click the mouse
again to toggle between an ascending or descending sort order.

Retrieved At field message
This area indicates the last time the Open Trouble Records List display was refreshed
or updated.

View Status
Click on a ticket (or row) to select it, then by clicking the View Status button, you
can view the status and log information for the trouble ticket.
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Closed Trouble Records window
This window is displayed by clicking the Retrieve button on the Trouble Search
window after choosing Closed in the Type field. This list can also be limited to just
telephone number trouble tickets or just circuit trouble tickets or both by the option
you choose in the Search For section of the Trouble Search window.

The title bar of this window indicates the Type and Search By parameters that you
selected in the Trouble Search window. This particular window is displaying a list of
all closed circuit trouble tickets from 5/28/99 to 6/4/99, based on the search criteria
provided in the Trouble Ticket Status and Ticket Search window. This list can be up
to 30 minutes old so recently closed tickets may not appear.

Columns in the Display
By positioning the mouse over one of the two-divider lines that define a column the
resize cursor will display,  . To change the column width hold down the mouse
button and drag the line until the desired column width is achieved.

The entire Open Trouble Records list can be sorted by in any column in ascending or
descending order. To change the sort, move the mouse over a column heading until
the  cursor displays. Click the mouse to sort by that column. Click the mouse
again to toggle between an ascending or descending sort order.

View Status
Click on a circuit’s ticket (or row) to select it, then by clicking the View Status
button, you can view the status and log information for the trouble ticket. This option
is not available for closed telephone number tickets, and will gray out if a telephone
number ticket is highlighted in the list.
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Retrieved At field message
This area indicates the last time the Closed Trouble Records list display was
refreshed or updated.

View History
Clicking the View History button with a telephone number trouble ticket highlighted
will display the Telephone Number History window.

Detailed ticket information, (as accessed through the View Status button for circuits),
is not available for telephone numbers. However, information on up to the last three
tickets within the last 90 days is available by clicking on the View History button.

Clicking on the View History button after highlighting a Circuit Trouble Report, will
display the Circuit History window for the circuit ID. From the Circuit History
window you can view the status of any trouble tickets displayed.

Report Trouble window
This window may be accessed by clicking the Report Trouble button from the
Trouble Administration Toolbar, or by clicking the Report Trouble option from the
Trouble menu.

This window will allow you to initiate either the telephone number or circuit trouble
reporting process.

Note: On some circuits, if you attempt to initiate a trouble report on a circuit that already has an open trouble
ticket, you will not be able to start another one, but you will be given the opportunity to view the status
on the existing ticket.

Telephone Number
Use this option to initiate a trouble report on a telephone number. This field has three
input areas: NPA, NXX and Number, where NPA is three numeric characters, NXX
is three numeric characters and Number is four numeric characters. Click in the field
windows and type in the numbers. When you are finished, click the Report Trouble
button. A warning window is displayed as following:
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If the Yes button is clicked, the Telephone Number Report Trouble window is
displayed, pre-filled with information on the number you entered. If the No button is
clicked, the transaction is cancelled.

Note: If the telephone number being reported is involved with a Joint Use Cable, a warning message will be
display stating:  “Joint Use Cable Indicator detected - End User may need to call vendor.” You will have
to acknowledge this message before a trouble report can be entered.

Circuit ID
Use this option to initiate a trouble report on a circuit. If you know the complete
circuit ID, type it into the field window. You may enter 2/6 Code of a message type
circuit id.

If you only know a partial circuit ID, then type in as much as you know and click the
Ckt Search button. This will launch the Circuit Inventory Search window pre-filled
with the partial circuit ID you entered. From there you can further refine your search,
eventually returning to the Report Trouble window pre-filled with a complete
circuit ID. This option is not available in the Pacific Bell / Nevada Bell region.

After you have a complete circuit ID entered, click the Report Trouble button.
Depending on the characteristics of the circuit ID you entered, either the Circuit
Trouble Report window or the Telephone Number Report Trouble window will
launch, pre-filled with information on the circuit you entered.
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Telephone Number Report Trouble
This window may be accessed by clicking the Report Trouble button after typing a
telephone number into the Report Trouble window.

This window allows you to initiate a new trouble report on a telephone number.

Telephone Number
This field message is pre-populated with the telephone number you typed into the
Report Trouble window. It indicates the number that you are reporting the trouble
on.

Reporter Name
This field message is pre-populated with your name from the profile information
stored in Trouble Administration.

Reporter Phone
This field message is pre-populated with your phone number from the profile
information stored in Trouble Administration.



Trouble Administration
User Guide                                                                                                                   

                                                                                                                                                                                                      
Proprietary - Not for use or disclosure outside of the SBC Family of Companies except by prior written agreement. Competitive Local Exchange Carriers
(CLECs) may use, reproduce, copy, and distribute the information solely for internal use in training employees to utilize the capabilities of this Southwestern
Bell Telephone Company, Pacific Bell, or Nevada Bell Operational Support System (OSS) in accordance with the OSS provisions of the Interconnection or
Resale Agreement between the CLEC and Southwestern Bell Telephone Company, Pacific Bell, or Nevada Bell. Additional or external use is strictly prohibited.
© Copyright 1998, 1999. Southwestern Bell Telephone Company. ALL RIGHTS RESERVED.

3-46

Trouble Type
This field is where you indicate the type of trouble that is occurring on the telephone
number you have indicated. This is a required field.

If you know the trouble type code, you can type it into the field window. When you
are finished typing, press the Tab key, or click in another field window, and if you
have entered a valid code, the Trouble description for that code will display. If you
have entered an invalid code, an error message will display.

Click the OK button to close the message box, then either retype a valid code or click
the Search button to display the Trouble Description window. The window displays
a list of codes and their descriptions that you can select from. After selecting a code,
you will be returned to the Telephone Number Report Trouble window and the
code and its description will have pre-filled the field windows.

Note: A list of trouble types can be found in Appendix D or in the online help.

Search
Click this button to display the Trouble Description window. The window displays
a list of codes and their descriptions that you can select from. After selecting a code,
you will be returned to the Telephone Number Report Trouble window and the
code and its description will have pre-filled the Trouble Type field window, and the
Trouble Description field message.

Trouble Description
This field message is automatically populated after you have typed a code into the
Trouble Type field and tabbed out of it or after you have selected a code from the
Trouble Description window.

Additional Information
This is a free-form text field. Click in the field window and then you can type up to
74 characters of information that may help describe the trouble. This is not a required
field.
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Premise Accessible panel

Contact Name
This field window is for reporting the name of a person who can be contacted at the
premises where the troubled telephone number is used. It is pre-filled with the name
that is associated with the owner of the telephone number you are reporting trouble
on. You may edit the name in this field if needed. This is not a required field.

Phone
This field window is for reporting a telephone number that can be used to contact a
person at the premises. Click in the field window and type in the telephone number.
This is a required field.

Service Address
This field message window is pre-filled with the name that is associated with the
owner of the telephone number you are reporting trouble on. You can not make edits
to this field.

Day
These fields are for indicating three days of the week that a technician can expect to
be able to gain access to the address for the telephone number you are reporting
trouble on. You must indicate at least two days that can be used for this purpose. The
first row defaults to the current day with the next two rows defaulting to the next two
days.

Click on the drop-down arrow to display the days of the week, then click on a day to
select it. Each row is a required field.

From Time / To Time
These fields are for indicating the time of day that a technician can expect to be able
to gain access to the address for the telephone number you are reporting trouble on.
You must indicate at least a 4-hour time span for each day that can be used for this
purpose. You can also enter 00:00 to 00:00 as the default time if there is no access to
premise that day.

Click in a field window and type in a From Time and a To Time for each day’s row.
You may type in times using the following formats: hh:mm am/pm, hh:mm (defaults
to am) or military hh:mm which converts to am/pm format.

Issue
After you have filled in the information for the trouble report, click on this button to
issue it. Trouble Administration will attempt to issue the new trouble ticket. If any
fields do not validate, the system will prompt you with a message box indicating
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what field needs attention. If all fields validate by the system the TRBLADMN –
CHECK message box will display.

The message reminds you to verify the Premises information on the trouble report
and that labor charges may be incurred. If you are satisfied with the information,
click the Yes button. The Report will be issued and a confirmation message will
display. If you want to verify the Premise information, click the No button and you
will be returned to the Telephone Number Report trouble window.

Close
Clicking this button closes the Telephone Number Report Trouble window and
removes all entered information.
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Circuit Trouble Report window

This window may be accessed by clicking the Report Trouble button after typing a
complete circuit ID into the Report Trouble window. It may also be accessed by
clicking the Report Trouble button from either the Circuit Inventory Search
Results window or the Circuit Legs window (except in PB/NB).

 This window allows you to initiate a new trouble report on a circuit.

Circuit ID

This field message is pre-populated with the circuit ID entered into the Report
Trouble window. If you have accessed this window by clicking the Report Trouble
button from either the Circuit Inventory Search Results window or the Circuit
Legs window (SWB only), it will be pre-populated with the circuit ID you had
highlighted there. This field indicates the circuit ID that you are reporting the trouble
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on. The following are valid circuit formats for PB/NB accounts to use when
populating this field:

Serial Circuit:
12/ABCD/123456/123/PT
12/ABCD/123456/123/PT/001

Carrier Circuit:
123/T1/ABCDEF11FFF/ABCDEF11FFF

Telephone Number Circuit:
/ABCD/123/123/1234
/SSSS/123/456/1234/D1

Message Circuit:
1000/AB5-AB/ABCDEF12ABC/MM/ABCDEF12ABC

2/6 Code:
AB123456/1

AB123456/1234

Reporter Name
This field message is pre-populated with your name from the profile information
stored in Trouble Administration.

Reporter Phone
This field message is pre-populated with your phone number from the profile
information stored in Trouble Administration. You may edit this field if needed.

Trouble Type
This field is where you indicate the type of trouble that is occurring on the circuit ID
that you have indicated. This is a required field.

If you know the trouble type code, you can type it into the field window. When you
are finished typing, press the Tab key, or click in another field window, and if you
have entered a valid code, the Trouble description for that code will display. If you
have entered an invalid code, an error message will display.

Click the OK button to close the message box, then either retype a valid code or click
the Search button to display the Trouble Description window. The window displays
a list of codes and their descriptions that you can select from. After selecting a code,
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you will be returned to the Circuit Trouble Report window and the code and its
description will have pre-filled the field windows.

Note: A list of trouble types can be found in Appendix D or in the online help.

Search
Click this button to display the Trouble Description window. The window displays
a list of codes and their descriptions that you can select from. After selecting a code,
you will be returned to the Circuit Trouble Report window and the code and its
description will have pre-filled the Trouble Type field window, and the Trouble
Description field message.

Trouble Description
This field message is automatically populated after you have typed a code into the
Trouble Type field and tabbed out of it, or after you have selected a code from the
Trouble Description window.

Customer Trouble Ticket Number
This field allows you to enter your own trouble report number. This is useful if you
have another trouble maintenance or tracking system with its own ticket number.
This Customer Trouble Ticket Number will be available to the Customer Care
Center (SWB) after you issue the trouble ticket. This option is not available in the
PB/NB region.

Additional Information
This is a free-form text field. Click in the field window and then you can type up to
774 characters of information that may help describe the trouble. This is not a
required field.

Dispatch Authority
In this section you may click the Yes or No radio buttons to indicate whether you are
giving Southwestern Bell the authority to come to the premises and work on the
problem. Careful consideration should be applied here, since it is possible to incur
charges for a dispatched technician’s time.

Premise A and Z Information
These sections are pre-populated with default information from the Trouble
Administration system. They indicate the name and address of persons who can be
contacted for premise access by a dispatched technician. You can edit any of the
information in the field windows if needed.
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Day
These fields are for indicating three days of the week that a technician can expect to
be able to gain access to the facility address and the circuit itself, for the circuit you
are reporting trouble on. You must indicate at least one day that can be used for this
purpose. The first row defaults to the current day with the next two rows defaulting to
the next two days.

Click on the drop-down arrow to display the days of the week, then click on a day to
select it. At least one row is a required field. This area is disabled if the Dispatch
Authority is set to No.

From Time / To Time
These fields are for indicating the time of day that a technician can expect to be able
to gain access to the facility address and the circuit itself, for the circuit you are
reporting trouble on. No minimum time span per day is enforced by Trouble
Administration, but indicating at least a 4-hour time span for each day should be
considered.

Click in a field window and type in a From Time and a To Time for each day’s row.
You may type in times using the following formats: hh:mm am/pm, hh:mm (defaults
to am) or military hh:mm which converts to am/pm format. This area is disabled if
the Dispatch Authority is set to No.

Intrusive Test Access
In this section you may click the Yes or No radio buttons to indicate whether you are
giving SWB/PB/NB the authority to access the circuit and interrupt its use, so the
problem can be worked. Careful consideration should be applied here, since it is
possible to incur charges for a technician’s time, as well as interrupt service to the
circuit.

If the Yes radio button is selected, the following warning will appear after clicking
the Issue button, “By selecting this option, an intrusive test will begin on this circuit
a couple of minutes after you issue the report.” In addition, the Circuit Available
section will be grayed out, meaning unlimited circuit access is granted to the
technician.

If the No radio button is clicked, the Circuit Available entry must be filled out with
a time that a technician can access the circuit. This access may include interruption of
circuit service.

Circuit Available
This field indicates the time that a technician can access the circuit. This access may
include interruption of circuit service.
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Click in a field window and type in a From Time and a To Time for each day’s row.
You may type in times using the following formats: hh:mm am/pm, hh:mm (defaults
to am) or military hh:mm which converts to am/pm format.

Issue
After you have filled in the information for the trouble report, click on this button to
issue it. Trouble Administration will attempt to issue the new trouble ticket. If any
fields do not validate, the system will prompt you with a message box indicating
what field needs attention. If all fields validate by the system the TRBLADMN –
CHECK message box will display.

The message reminds you to verify the Premises information on the trouble report. If
you are satisfied with the information, click the Yes button. The Report will be issued
and a confirmation message will display. If you want to verify the Premise
information, click the No button and you will be returned to the Telephone Number
Report trouble window.

Close
Clicking this button closes the Circuit Trouble Report window and removes all
entered information.

Trouble Description window
This window is accessed by clicking the Search button from either the Telephone
Number Report Trouble window or the Circuit Trouble Report window.
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This window is used to select a trouble code for input into the either the Telephone
Number Report Trouble window or the Circuit Trouble Report window.

Display
The display has three columns that list the code or group-code itself, a description for
what the code or group means, and the action that the code is used for. You can scroll
down the list to find the appropriate code, then click on an entry to highlight it for
either selection or expansion.

Select
Once you have highlighted the code that you want to use, click the Select button, and
you will be returned to the Trouble Report window you searched from and the code
and its description will have pre-filled the field windows.
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Expand
When you have highlighted a Code Group, you can click the Expand button to
display a subset of codes that belong to that group. The subset is displayed in the
Trouble Description Group window.

The title bar of this window displays the name of the Group you expanded from.

Select
Once you have highlighted the code that you want to use, click the Select button, and
you will be returned to the Trouble Report window you searched from and the code
and its description will have pre-filled the field windows.

Collapse
To return to the Trouble Description window, click the Collapse button.
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Binding Post
This window may be accessed by clicking the Binding Post icon on the Trouble
Administration toolbar or clicking the Initiate Binding Post from the Binding Post
menu.

This window will allow you to initiate Binding Post retrieval for a 10-digit telephone
number.

Note: Binding Post is available only on POTS services in the PB/NB region.

Telephone Number
This field has three input areas: NPA, NXX and Number, where NPA is three
numeric characters, NXX is three numeric characters and Number is four numeric
characters. Click in the field windows and type in the numbers. When you are
finished typing, you may click the Retrieve button to start the test. After clicking the
Retrieve button, a warning message window will be displayed if your company
profile indicates that the TN entered is not part of your company profile.

Clear
Clicking on this button will clear any information you have typed into the field
windows. This is useful for entering several numbers to test in one session.
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Binding Post Results window
This window is displayed as a result of clicking the Retrieve button on the Binding Post window.
This window may be saved to a file or printed.
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Appendix  A   Telephone Number Status Descriptions-LMOS

ANSI 227 - TROUBLE
STATUS DESCRIPTION

227
CODE

LMOS
STATUS
CODE

LMOS DESCRIPTION

screening 1 PS Pending Screen
PSH Pending Screen Human
PSM Pending Screen MLT Tested
PAB Pending Alternate Bureau
TPA TRUST - Pending Action
TSA TRUST - Retest And New Service
TSM TRUST Screening Multi Report
PRD Pre-assigned Out
CON Unassigned
PWS Unassigned
PWF Air Pressure
HLD Held -Removed from Dispatch Pool

testing 2 PUT Unassigned
TST CSB Screening Pool

dispatchedIn 3 DPI Dispatched In
dispatchedOut 4 DPO Dispatched Out
preassignedOut 5 PAO Pre-assigned Out

PFJ Pre-assigned First Job
bulkDispatchedOut 6 BDO Bulk Dispatch Out

BKO Back Ordering Equipment
startRepair 7 PWS Unassigned
pendingTest 8 PDT Pending Test
pendingDispatch 9 PD2 Drop Recon

PD3 Locates
PD4 Customer Provided Inside Wire
PD5 Drops (i.e., Low, Cut, etc.)
PDB Pending Dispatch - No LINK Retest
PDC Pending Dispatch - Coin
PDF Pending Dispatch - Facility
PDG Pending Dispatch - Pair Gain
PDI Pending Dispatch In
PDM Pending Dispatch - Multiple
PDO Pending Dispatch - LINK Retest
PDS Pending Dispatch - MAC/IECC

Customers
DDO Delayed Dispatch Out
DFJ Delayed First Job
RMR Repair Returned After Dispatch

requestRepair 10
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ANSI 227 - TROUBLE
STATUS DESCRIPTION

227
CODE

LMOS
STATUS
CODE

LMOS DESCRIPTION

referMtceCenter 11 RBC Referred To Business Center
RCC Referred To Control Center
ROP Referred To Outside Plant - SAB'd
RRC Referred To RMATS - SAB'd
RSC Referred To SCC - SAB'd
RSS Referred To SCC - SAB'd

referVendor 12
noAccessOther 13 NAO No Access - Place Other Than

Subscribers Premise Not Accessible

NAS No Access - Subscribers Premise
startNoAccess 14
stopNoAccess 15
startDelayedMtce 16
stopDelayedMtce 17
troubleEscalated 18 RFC Referred To a Center
craftDispatched 19
temporaryOK 20 TMK Temporarily OK - Pending Further

Testing
TDA Tested OK - Doesn't Answer

cableFailure 21 CAF Splicer Openings
DFC Defective Conductor

originatingEquipFailure 22 OEF Office Equipment Failure
backOrder 23
clearedCustNotAdvised 24 CNA Cleared - Customer NOT Advised
clearedCustAdvised 25
clearedAwaitingCustVerification 26 CCA Cleared - Customer Advised
closedOut 27 CLO Trouble Closed

STA Start Clock On Closed Trouble
Report For Analysis

STO Stop Clock On Closed Trouble
Report

closedOutByCustReq 28
closedOutCustVerified 29
closedOutCustDenied 30
canceledPendingWorkInProgress 31
canceledPendingTestCompletion 32
canceledPendingDispatchCompl 33
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Appendix  B   Telephone Number Trouble Cause Codes-LMOS

CAUSE CODE 1** -
        11*          Installation
        12*          Repair
        13*          Outside Plant Construction
        14*          Outside Plant Maintenance
        15*          Central Office
        16*          Unidentifiable
        171          Engineering
        172          Assignment
        173          Service Order Completion Center
        174          Recent Change Memory Administration Center (RCMAC)
        175          Residence/Business/Public Service Center
        176          Maintenance Administrator
        177          Repair Dispatcher
        178          Network Administration Center (NAC)
        179          Collection Service Center (CSC)
        170          Administration - Other
        18*          Non Visit Service Order
        19*          Reserved For Future Application
        10*          Telephone Company Employee - Other

CAUSE CODE 2** NONEMPLOYEE
        21*          Vendor
        22*          Contractor
        23*          Customer Action
        241          Gas
        242          Electric
        243          Community Antenna Television (CATV)
        244          Sewer
        245          Water
        246          Independent Telephone Company
        247          Highway
        248          Available For Local Use
        249          Available For Local Use
        240          Utility - Other
        25*          Reserved For Future Application
        26*          Reserved For Future Application
        27*          Reserved For Future Application
        28*          Available For Local Use
        29*          Available For Local Use
        20*          Nonemployee - Other

 CAUSE CODE 3** PLANT OR EQUIPMENT
        31*          Defective
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        32*          Adjustment
        33*          Overload
        34*          Cable Facilities
        35*          Cable Facilities
        36*          Pair Gain System/Single Channel
        37*          Pair Gain System/Multichannel Analog
        38*          Pair Gain System/Multichannel Digital
        39*          Pair Gain System/Switch
        30*          Plant or Equipment - Other

 CAUSE CODE 4** WEATHER
        41*          Lightning
        42*          Moisture
        43*          Flood
        44*          Wind
        45*          Hurricane/Tornado
        46*          Ice/Sleet/Snow
        47*          Temperature
        48*          Available For Local Use
        49*          Available For Local Use
        40*          Weather - Other

 CAUSE CODE 5** OTHER
        51*          Fire
        510          Service Order via TAN/LINK
        52*          Insects
        53*          Rodents/Reptiles
        54*          Birds
        55*          Other Animals
        56*          Trees/Foliage
        57*          Power
        58*          Available For Local Use
        59*          Available For Local Use
        50*          Other

CAUSE CODE 6** UNKNOWN
        61*          Available For Local Use
        62*          Available For Local Use
        63*          Available For Local Use
        64*          Available For Local Use
        65*          Available For Local Use
        66*          Available For Local Use
        67*          Available For Local Use
        68*          Available For Local Use
        69*          Available For Local Use
        60*          Unknown
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Appendix  C   Telephone Number Trouble Disposition Codes-LMOS

031* Premise Termination
032* Available
033* Available
034* Available
035* Available
0361 Drop - Not Buried
0362 Drop - Physical Appearance, Buried Drop
0363 Drop - Tree Foliage or Trimming around Drop / Service Wire
0364 Drop - Damaged by TELCO Contractor while Burying
0365 Available
0366 Available
0367 Available
0368 Available
0369 Available
0360 Available
0370 Network Termination - Other
0371 Network Termination - Protector Unit / Carbons
0372 Network Termination - Protector Housing
0373 Network Termination - Network Interface - Inside
0374 Network Termination - Network Interface - Outside
0375 Network Terminating Wire
0376 Available
0377 Network Termination - Ground Wire/Connections
0378 Network Termination - Side Wall Termination – Jumper Missing
0379 Network Termination - Side Wall Termination – Jumper Wrong
0380 Drop Service Wire - Proven in Drop – Came Clear
0381 Drop Service Wire - Aerial
0382 Drop Service Wire - Temp Drop Not Buried Recon
0383 Drop Service Wire - Buried Repaired Initial Dispatch
0384 Drop Service Wire - Buried Temporary Placed – No Recon
0385 Drop Service Wire - Buried Temp Placed Recon
0386 Drop Service Wire - Removed Dead Drop
0387 Drop Service Wire - Reversed Drop
0388 Drop Service Wire - Buried Service Wire Detach/Rewire
0389 Drop Service Wire - Temp Drop Not Buried Repaired
0390 Network Miscellaneous Apparatus - Other
0391 Ntwk. Misc. Apparatus - Defective MTU - PCA
0392 Ntwk. Misc. Apparatus - Half Ringer Termination
0393 Ntwk. Misc. Apparatus - Defective Radio Suppressor/Noise Filter
0394 Ntwk. Misc. Apparatus - Placed Radio Suppressor/Noise Filter
0395 Ntwk. Misc. Apparatus - Smart Terminating Equipment – Replace (STE)
0396 Ntwk. Misc. Apparatus - 5 – Pin Protector
0397 Ntwk. Misc. Apparatus - EEID
0398 Available
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0399 Available
030* Available
0410 Cable - Conductor Reversed
0411 Cable - Sheath / Core
0412 Cable - Load Coil
0413 Cable - End Cap
0414 Cable - Stub
0415 Cable - Aerial Cable Damaged
0416 Cable - Conductor
0417 Cable - Cut/damaged cable - located
0418 Cable - Cut/damaged cable - not located
0419 Cable - Cut/damaged cable – bad locate
0420 Closure/Splice Case – Came Clear
0421 Closure/Splice Case – Temp Closure
0422 Closure/Splice Case – Lead Sleeve
0423 Closure/Splice Case – Encapsulated Splice
0424 Closure/Splice Case – SAI / RAI / Crossbox
0425 Closure/Splice Case – Cable Vault
0426 Closure/Splice Case – Splice Case/Closure – Non Pressurized
0427 Closure/Splice Case – Splice Case/Closure - Pressurized
0428 Closure/Splice Case – Damaged Pedestal / Closure
0429 Closure/Splice Case – Heat Shrink
0430 Terminal – Came Clear
0431 Terminal – Ready Access - Aerial
0432 Terminal – Ready Access - Buried
0433 Terminal – Fixed Count - Aerial
0434 Terminal – Fixed Count - Buried
0435 Terminal – Out of Sight
0436 Terminal – SAI / RAI / Crossbox
0437 Available
0438 Available
0439 Available
0440 Wire/Plant Support Wire – Came Clear
0441 Wire/Plant Support Wire – Open Wire
0442 Wire/Plant Support Wire – Urban/Rural
0443 Wire/Plant Support Wire – Dual Plant
0444 Wire/Plant Support Wire - Capacitor
0445 Wire/Plant Support Wire - Vent
0446 Wire/Plant Support Wire – Load Coil
0447 Wire/Plant Support Wire - Conduit
0448 Wire/Plant Support Wire – Pole/Guy/Anchor
0449 Wire/Plant Support Wire – Stand/Bolts/Arm
0450 Fiber – Came Clear
0451 Fiber – MUX
0452 Fiber – Light Wave Cable
0453 Fiber – Regenerate Equipment
0454 Fiber – Optical Conductor
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0455 Fiber - Splice
0456 Fiber – Plug INs
0457 Fiber – Fiber Cable
0458 Available
0459 Available
0460 Available
0461 Available
0462 Available
0463 Other Cable Fac. Or Carrier Span – Multiplexor
0464 Other Cable Fac. Or Carrier Span – Span (cooper)
0465 Other Cable Fac. Or Carrier Span – Span (fiber)
0466 Other Cable Fac. Or Carrier Span – Plug Ins
0467 Other Cable Fac. Or Carrier Span – Trunk
0468 Other Cable Fac. Or Carrier Span – Repeater / Mid Span
0469 Other Cable Fac. Or Carrier Span – Repeater / Premise
0470 Pair Gain System – Came Clear
0471 Pair Gain System – Common Circuit Pack
0472 Pair Gain System – Rectifier Failure
0473 Pair Gain System – Power Failure (Commercial)
0474 Pair Gain System – Routing
0475 Pair Gain System – Channel Unit – Exchange
0476 Pair Gain System – Channel Unit – Special
0477 Pair Gain System – Repeater Failure
0478 Pair Gain System – Alternate Power Source
0479 Pair Gain System - Wiring
0480 Cable Misc. – Came Clear
0481 Cable Misc. – DAML / AML / SLC1
0482 Cable Misc. – Trench
0483 Cable Misc. – Cable Console or Tone on line
0484 Cable Misc. – Range Extender
0485 Cable Misc. - Rural Radio
0486 Cable Misc. – DDL Unit
0487 Cable Misc. – Squirrel Guard
0488 Cable Misc. – Tree Trim - Cable
0489 Cable Misc. – Dead / Abandoned / Non Telco Cable
049* Available
0401 Pair Transferred
0402 Pair Cut Dead To Field
0403 Pair Transposed
0404 Defective Section/Temporary Drop Placed
0405 Defective Encapsulated Pair
0406 Bridge Tap Removed
0407 Pair Transferred - No Defective Pair Left - Installation
0408 Pair Transferred – No Defective Pair Left - Maintenance
0409 Pair Gain Pair LST’d
0400 Other – Not Repaired
0511 CO Equipment - Common Equipment
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0512 CO Equipment - Linkage/Network/Grid
0513 CO Equipment - Line Equipment
0514 CO Equipment - Billing Equipment
0515 CO Equipment - Trunk
0516 CO Equipment - Public Service Trunk
0517 CO Equipment - Power / Fuse
0518 CO Equipment - Generic Switch Upgrade / Parameter
0519 CO Equipment - NTG / CTG Translations
0510 CO Equipment – Line Int. Unit / Line Card
0521 CO Translation - General Work Error
0522 CO Translation - Generic Program Error
0523 CO Translation - Parameter Work Error
0524 CO Translation - Parameter Document Error
0525 CO Translation - Line-Work Error
0526 CO Translation - Line-Document Error
0527 CO Translation - Network-Work Error
0528 CO Translation - Network-Document Error
0529 CO Translation - MIZAR
0520 CO Translation - OTHER
0531 CO Distribution Frame - MDF Cross-Connect Missing
0532 CO Distribution Frame - MDF Cross-Connect Broken
0533 CO Distribution Frame - MDF Cross-Connect Work Error
0534 CO Distribution Frame - MDF Cross-Connect DOC Error
0535 CO Distribution Frame - OTHER Cross-Connect Work Error
0536 CO Distribution Frame - OTHER Cross-Connect DOC Error
0537 CO Distribution Frame - Billing Cross-Connect Work Error
0538 CO Distribution Frame - Billing Cross-Connect DOC Error
0539 CO Distribution Frame - Intercept Or Disconnect Work Error
0530 CO Distribution Frame - Intercept Or Disconnect DOC Error
0541 CO Frame Other - Defective Or Operated Protector
0542 CO Frame Other - Missing Protection Device
0543 CO Frame Other - Reversing Device
0544 CO Frame Other - Terminal-Wire Clipping
0545 CO Frame Other - Terminal-Connection
0546 CO Frame Other - Test Cord
0547 CO Frame Other - Translator / CEBS
0548 Available
0549 Available
0540 CO Frame Other - Other
0551 CO Power - DC Power Equipment
0552 CO Power - AC Power Equipment
0553 CO Power - Ringing Plant
0554 CO Power - Standby Emergency Power
0555 Available
0556 Available
0557 Available
0558 Available
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0559 Available
0550 CO Power - Other
0561 CO Misc. Equipment - Radio System
0562 CO Misc. Equipment - Line Testing Equipment
0563 CO Misc. Equipment - Concentrator
0564 CO Misc. Equipment - Range Extender
0565 CO Misc. Equipment - Carrier System
0566 CO Misc. Equipment - AMARC
0567 CO Misc. Equipment - Cinch Connector
0568 CO Misc. Equipment - Bridge Lifter
0569 CO Misc. Equipment - Test Equipment / Test Port
0560 CO Misc. Equipment - Other
0571 CO Special Service Equip. - Design
0572 CO Special Service Equip. - Wiring Option
0573 CO Special Service Equip. - Carrier Channel
0574 CO Special Service Equip. - Signaling
0575 CO Special Service Equip. – Repeater / MTM
0576 CO Special Service Equip. – Loopback Device
0577 CO Special Service Equip. - Bridge
0578 CO Special Service Equip. - Billing
0579 Available
0570 CO Special Service Equip. - Other
0581 CO Pair Gain System - Translations / Digital Crossconnection
0582 CO Pair Gain System - Signaling
0583 CO Pair Gain System - Common Circuit Pack
0584 CO Pair Gain System - Channel Unit Exchange
0585 CO Pair Gain System - Channel Unit Special
0586 CO Pair Gain System - MUX
0587 CO Pair Gain System – Power/Fuse
0588 CO Pair Gain System – Wiring/Frame
0589 CO Pair Gain System - RSS/LSS Switch Extension Module
0580 CO Pair Gain System - Mounting
0591 CO Data Base Services - Calling Card Service (CCS)
0592 CO Data Base Services - Automatic Intercept System (AIS)
0593 CO Data Base Services - Expanded 911 Service
0594 Available
0595 Available
0596 Available
0597 CO Data Base Services - 700 Services
0598 CO Data Base Services - Expanded 800 Service
0599 CO Data Base Services - Dial It Service
0590 CO Data Base Services - Other
0501 CO Data Base Services - VMS Line Attribute Translation
0502 CO Data Base Services - VMS Switch Translation
0503 CO Data Base Services - AIS/MICAIS
0504 CO Data Base Services - 911 Database Tandem
0505 Available
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0506 Available
0507 Available
0508 Available
0509 Available
0500 CO Data Base Services - Other
06* Customer Action
061* Available
062* Available
063* Available
064* Available
065* Available
066* Available
067* Available
068* Available
069* Available
0601 Customer Instruction - Equipment
0602 Customer –Instruction - TDD
0603 Customer Action – Call Forwarding – MTCE Busy
0604 Customer Action – Call Forwarding – Toll Fraud
0605 Customer Action – Front End Close – Customer Instruct by CVAS
0606 Customer Action – Voice Activated Dialing not Installed
0607 Available
0608 Available
0609 Available
0600 Customer Instruction - Features
071* No Test MC / CSB
0715 No Test MC / CSB - Customer Cancelled Report
072* Mtce. Center Only
0721 Mtce. Center – Retest OK – Came Clear
0722 Mtce. Center – TELCO Test Link – EMP FST – Customer Contacted
0723 Mtce. Center – TELCO Test Link – EMP FST – Customer Not Contacted
0724 Mtce. Center – TELCO Test Link – Auto FST
073* Test OK – Technician
074* Test OK - CSB Front End Close
075* Test OK – SCC / FMC
076* Available
077* Available
078* Available
079* Available
0700 Available
0701 Test OK CSB – Verified OK with Customer
0702 Test OK CSB – Customer Does Not Answer
0703 Test OK CSB – Central Office Overload
0704 Test OK CSB – Retest OK Screener
0705 Test OK CSB – Can’t Call Long Distance
0706 Available
0707 Available
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0708 Available
0709 Available
081* Found OK In - No Test Made
0811 Found OK In
0812 Found OK In – Change O.E. on Suspicion
0813 Found OK In – Restored from Hi and Dry
082* Available
083* Available
084* Available
085* Available
086* Available
087* Available
088* Available
089* Found OK In - Data Base Services
0891 Found OK In – Data Base Services – Calling Card Service (CCS)
0892 Found OK In – Data Base Services – Auto Intercept System (AIS)
0893 Found OK In – Data Base Services – Expanded 911 Service (E911)
0894 Available
0895 Available
0896 Available
0897 Found OK In – Data Base Services – 700 Services
0898 Found OK In – Data Base Services – Expanded 800 Service
0899 Found OK In – Data Base Services – Dial IT Service
0890 Found OK In – Data Base Services – Other
080* Available
091* Found OK Out – Cable Dispatch
0910 Found OK Out – Cable Dispatch – Other
0911 Found OK Out – Cable Dispatch – Open Out
0912 Found OK Out – Cable Dispatch – Ground
0913 Found OK Out – Cable Dispatch – Short
0914 Found OK Out – Cable Dispatch – FEM
0915 Found OK Out – Cable Dispatch – Multiple Trouble Indications
0916 Found OK Out – Cable Dispatch – Noisy/Unbalanced
0917 Found OK Out – Cable Dispatch – Test OK
0918 Found OK Out – Cable Dispatch – No Test Required
0919 Found OK Out – Cable Dispatch – Equipment Left at Job Site
092* Available
093* Available
094* Available
095* Available
096* Found OK Out – Exchange Dispatch
0960 Found OK Out – Exchange Dispatch - Other
0961 Found OK Out – Exchange Dispatch – Open Out
0962 Found OK Out – Exchange Dispatch - Ground
0963 Found OK Out – Exchange Dispatch - Short
0964 Found OK Out – Exchange Dispatch - FEMF
0965 Found OK Out – Exchange Dispatch – Multiple Trouble Indications
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0966 Found OK Out – Exchange Dispatch – Noisy/Unbalanced
0967 Found OK Out – Exchange Dispatch – Test OK
0968 Found OK Out – Exchange Dispatch – No Test Required
0969 Found OK Out – Exchange Dispatch – Equipment Left at Job Site
097* Available
098* Available
099* Available
090* Available
1011 Common Network Elements – Digital Data Service – Power/Fuse
1012 Common Network Elements – Digital Data Service – OCU / T1DM
1013 Common Network Elements – Digital Data Service – T1E
1014 Common Network Elements – Digital Data Service – Sub Rate Multiplex
1015 Common Network Elements – Digital Data Service – Timing
1016 Common Network Elements – Digital Data Service – Mounting / Slot / Backplane
1017 Common Network Elements – Digital Data Service – Secondary Channel
1018 Common Network Elements – Digital Data Service – IOP Bay / Circuit Pack
1019 Available
1010 Common Network Elements – Digital Data Service – Other
1021 Common Network Elements – Digital Transport Equip. - Wiring
1022 Common Network Elements – Digital Transport Equip. – DSX Bay / Jacks
1023 Common Network Elements – Digital Transport Equip. - MUX
1024 Common Network Elements – Digital Transport Equip. – Power / Fuse
1025 Common Network Elements – Digital Transport Equip. – Repeater Mounting
1026 Common Network Elements – Digital Transport Equip. - FOT
1027 Common Network Elements – Digital Transport Equip. – Test Access
1028 Common Network Elements – Digital Transport Equip. – DSL CO Unit
1029 Available
1020 Common Network Elements – Digital Transport Equip. - Other
1031 Common Network Elements – LNP Network Elements - Space
1032 Common Network Elements – LNP Network Elements - ISCP
1033 Common Network Elements – LNP Network Elements - NetPilot
1034 Common Network Elements – LNP Network Elements - STP
1035 Common Network Elements – LNP Network Elements – DataCom Link to N.E.
1036 Available
1037 Available
1038 Available
1039 Available
1030 Common Network Elements – LNP Network Elements - Other
1041 Common Network Elements - STP - Common Equipment
1042 Common Network Elements - STP - Cluster Related Equipment
1043 Common Network Elements - STP - Link Related Equipment (Circuit Packs)
1044 Common Network Elements - STP - Generic
1045 Common Network Elements - STP - Translation
1046 Common Network Elements - STP - Wiring
1047 Common Network Elements - STP - Power
1048 Common Network Elements - STP - Misc. Equip. (AMA, Support Systems, Etc.)
1049 Common Network Elements - STP - Facility (DCS, Carrier)
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1040 Common Network Elements - STP - OTHER
1051 Common Network Elements - SCP - Common Equipment
1052 Common Network Elements - SCP - Service Network Interface (Frontend)
1053 Common Network Elements - SCP - Link Related Equipment (Data Sets)
1054 Common Network Elements - SCP - Generic
1055 Common Network Elements - SCP - Translation
1056 Common Network Elements - SCP - Wiring
1057 Common Network Elements - SCP - Power
1058 Common Network Elements - SCP - Misc. Equip. (AMA, Support Systems, Etc.)
1059 Common Network Elements - SCP - Facility (Carrier)
1050 Common Network Elements - SCP - OTHER
1061 Common Network Elements – Internet Services – ICW Server Generic Software
1062 Common Network Elements – Internet Services – Registration Server Hardware
1063 Common Network Elements – Internet Services – Registration Server Generic Software
1064 Common Network Elements – Internet Services – Registration Server Translation Error
1065 Common Network Elements – Internet Services – Heartbeat Server Software
1066 Common Network Elements – Internet Services – Heartbeat Server Generic Software
1067 Common Network Elements – Internet Services – ICID Client Software
1068 Common Network Elements – Internet Services – EMS Work Document In Error
1069 Common Network Elements – Internet Services – DNS Translation Error
1060 Common Network Elements – Internet Services – ICW Server Hardware
1071 Common Network Elements – Internet Services – Pwr. and Misc. Equip. for ICID Hard.
1072 Available
1073 Available
1074 Available
1075 Available
1076 Available
1077 Available
1078 Available
1079 Available
1070 Common Network Elements – Internet Services – ISP interface Incl. Router / Firewall
1081 Common Network Elements - Database Services - AIN Hardware or Common Equip
1082 Common Network Elements - Database Services - AIN Generic Software
1083 Common Network Elements - Database Services - AIN Logic in Error
1084 Common Network Elements - Database Services - AIN Work Document in Error
1085 Common Network Elements - Database Services - IP Hardware
1086 Common Network Elements - Database Services - IP Generic Software
1087 Common Network Elements - Database Services - IP Logic in Error
1088 Common Network Elements - Database Services - IP Work Document in Error
1089 Common Network Elements - Database Services - Power/Misc. Equip for AIN/IP Hardware
1080 Common Network Elements - Database Services - IMS Hardware
109* Available
1001 Common Network Elements – Other – Local Tandem
1002 Common Network Elements – Other – Access Tandem
1003 Common Network Elements – Other – TOPS
1004 Common Network Elements – Other – 800 Database
1005 Common Network Elements – Other – SS7
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1006 Common Network Elements – Other – NCC
1007 Common Network Elements – Other – Line Load Control
1008 Available
1009 Available
1000 Common Network Elements – Other – Other
1211 CPE Maint Contract - Loaner Set Provided or Set Sold
1212 CPE Maint Contract – Set/Equipment Trouble InLine Only
1213 CPE Maint Contract - Non Standard IW (Customer Repair)
1214 CPE Maint Contract - CPIW/CPE Jack
1215 CPE Maint Contract - Non Standard CPIW (Telco Repaired)
1216 CPE Maint Contract - Arkansas Only – Set or ROH for OWM Cust.
1217 CPE Maint Contract - No Access – Field or Mtce. Center Use
1218 CPE Maint Contract - Damage Caused By Nature/Acts of God
1219 CPE Maint Contract - InLine Plus Drop Shipment
1210 CPE Maint Contract - Cord
1221 CPE Other – Radio Suppressor
1222 CPE Other – Set/Equipment
1223 CPE Other – CPE (IW/CPE) – No Dispatch
1224 CPE Other – CPE (IW/CPE) - Dispatch
1225 CPE Other – PC Hardware/Software
1226 CPE Other – Cordless Telephone Set Sold
1227 Available
1228 CPE Other – Multi-Line Telephone Set Sold
1229 CPE Other – Cable Not TELCO maintained
1220 CPE –Other – Receiver Off Hook
1230 Available
1231 IC services – no trouble in TELCO
1232 Available
1233 No WireWorx, no NI, Trouble in CPE, No MSC
1234 Available
1235 No WireWorx - MSC Applies
1236 WireWorx, End User Repair - MSC Applies (line not covered)
1237 WireWorx, TELCO Repair - MSC & TSC Apply (line not covered)
1238 WireWorx, TELCO Repair - No TSC (line covered) - MSC Applies if  CPE Trbl
1239 WireWorx, Refer to LSP - Nonstandard Wire - LSP to Issue Serv. Ord (line covered)
1241 Contract Work – Contract I/M Services - CPE
1242 Contract Work – Contract I/M Services - Wire
1243 Contract Work – Cable – Customer Owned/Provided – Service Agreement - Repair
1244 Contract Work – Cable – Customer Owned/Provided – No Service Agreement - Repair
1245 Contract Work – Cable – Customer Owned/Provided – Service Agreement - Locate
1246 Contract Work – Cable – Customer Owned/Provided – No Service Agreement - Locate
1247 Available
1248 Available
1249 Available
1240 Contract Work – Service Agreement – Non-cable
1251 CPE - Customer Premises Cabling - Referred to Vendor
1252 CPE - Customer Premises Cabling - Complex Customer
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1253 CPE - Customer Premises Cabling - Simple Wire Customer
1254 CPE - Customer Premises Cabling - LAN Software
1255 CPE - Customer Premises Cabling - Complex Media
1256 CPE - Customer Premises Cabling - BDS/LAN
1257 Available
1258 Available
1259 Available
1250 Available
1261 CPE - TSW/Isolation - No Mtce. Contract - Inside Wire Telco Repair
1262 CPE - TSW/Isolation - No Mtce. Contract - Inside Wire-SNI not Available - Customer Repair
1263 CPE - TSW/Isolation - No Mtce. Contract – Inside Wire – SNI Available –Customer Repair
1264 CPE - TSW/Isolation - No Mtce. Contract - No Authorization
1265 CPE - TSW/Isolation - No Mtce. Contract - Military Facility
1266 CPE - TSW/Isolation - No Mtce. Contract – CPE/CPW No Access– No SNI
1267 CPE - TSW/Isolation - No Mtce. Contract – CPE/CPW No Access - SNI
1268 CPE - TSW/Isolation - No Mtce. Contract - Warranty
1269 CPE - TSW/Isolation - No Mtce. Contract – Mounting Cord Replacement
1260 CPE - TSW/Isolation - No Mtce. Contract – Arkansas Only – Complex Bus.
1271 Non-Customer Initiated Trouble – Predictor/SCAN/ALIT
1272 Available
1273 Available
1274 Available
1275 Non-Customer Initiated Trouble - Wire Check Toll Fraud by Field and Found OK
1276 Non-Customer Initiated Trouble – Wire Check Toll Fraud by CO and Found OK
1277 Available
1278 Available
1279 Available
1270 Available
1281 CSB Admin only – Front End Close Out - TOK
1282 CSB Admin only – Third Party Report - TOK
1283 CSB Admin only – Refer to Long Distance Vendor
1284 CSB Admin only – 2nd or more Request for Loaner
1285 CSB Admin only – CSB Reserve
1286 Available
1287 Available
1288 Available
1289 Available
1280 Available
1291 Miscellaneous - Billing Error Corrections/Additional Increments
1292 Miscellaneous - PIC Verify
1293 Miscellaneous – SPORT Center – ILEC caused in ILEC CO
1294 Miscellaneous – SPORT Center – ILEC caused in ILEC Outside Plant
1295 Miscellaneous – SPORT Center – ILEC caused LNP trouble
1296 Miscellaneous – SPORT Center – Service Order due date missed by ILEC
1297 Available
1298 Available
1299 Available
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1290 Available
1201 CPE - Other - Voice Messaging Service – Customer Instructed
1202 CPE - Other – Voice Messaging Service – Customer Owned
1203 CPE - Other – DSE – Hardware Problem
1204 CPE - Other – DSE – System Programming
1205 CPE - Other – Refer to Direct TV / USSB
1206 CPE - Other – Refer to Vendor
1207 CPE - Other – Unauthorized CPE/CPW – Usage Tariff Violation
1208 CPE - Other – Home Security – Hardware Trouble
1209 CPE - Other – Home Security – Programming Trouble
1200 CPE - Other – Wire / Jacks
1301 Requests For Directories
1302 Temporary Dual Service Arrangements
1303 Employee Commendations
1304 CVAS Disconnect or Hang Up
1305 Information Furnished By Another Dept.
1306 Requests For Location Of TELCO Plant
1307 Requests To Raise, Lower, Or Move Wires
1308 Line Unassigned, Suspended, Or Disconnected
1309 Feature Problem For Which Cust Is Not Paying
1310 Verify Busy
1311 Wires Down or Poles Broken
1312 Trouble Report on Special Circuit
1313 Incorrect Or Incomplete Records
1314 Connection Of Ground To Electrical Power Ground
1315 Wide Area Telephone Service (WATS) or Toll Special Service
1316 Serv Ord Activity Rec’d Prior to Midnight of Due Date
1317 Trbl on 2nd # Where Both #'S Were Given, But Trbl on 2ND Only
1318 Available
1319 Available
1320 Request from Business Office
1321 Customer Unable to Reach Business Office
1322 Request from Vendors to do Testing
1323 Changes in Network Structures, i.e., 10-Digit Dialing
1324 Miscellaneous, Request for Nearest Payment Agency, Freedom Phone Repairs, etc.
1325 Available
1326 Available
1327 CLEC requests information available thru Electronic Interfaces
1328 CLEC report generated in error
1329 Resold to UNE-Loop & Port Combo conversion order error caused by CLEC generating

Service Order on wrong customer addresse
1330 Available
1331 LNP Premature Disconnect - FDT with loop

( For tracking puposes only - Not performance measure impacting )
1332 LNP Premature Disconnect - FDT without loop

( For tracking puposes only - Not performance measure impacting )
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1333 LNP Premature Disconnect - CHC with loop
( For tracking puposes only - Not performance measure impacting )

1334 LNP Premature Disconnect - CHC without loop
( For tracking puposes only - Not performance measure impacting )

1335 Cust Req Serv Guarantee Disp Out - No Serv Guarantee Granted by Tech
1336 Cust Req Serv Guarantee Disp Out - Serv Guarantee Granted by Tech
1337 Available
1338 Available
1339 Available
1340 Front End Close for Call Notes
1341 Available
1342 Available
1343 Available
1344 Available
1345 Available
1346 Available
1347 Available
1348 Available
1349 Available
1356 CLEC request line conditioning (removal of load coils, excessive bridge tap, &/or repeaters)

after ordering yellow zone (YZP) DSL loop via PSD ordering process. **The "non-
conditioning required" DSL service order must be complete. (Billing applies on per element
conditioned basis)

135* Available
136* Available
1374 Refer End User or Trouble Proven to Data Service Provider
1375 CLEC request for Conditioning or additional Conditioning on xDSL
137* Available
1380 Available
1381 Available
1382 Available
1383 Available
1384 Available
1385 Available
1386 Available
1387 Available
1388 Available
1389 Available
139* Available
14** Available
15** Available
16** Public Services Set (S N E T)
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Appendix  D   Trouble Type Codes and Descriptions

Trouble Code Trouble Description Action

100 noDialToneGroup Report Trouble

101 noDialTone Report Trouble

102 slowDialTone Report Trouble

103 circuitDead Report Trouble

200 canNotCallOutGroup Report Trouble

201 canNotCallOut Report Trouble

203 canNotBreakDialTone Report Trouble

204 dialToneAfterDialing Report Trouble

205 highAndDry Report Trouble

206 canNotRaise Report Trouble

207 allAccessBusy Report Trouble

208 canNotCallOut2 Report Trouble

209 canNotCallLongDistance Report Trouble

210 canNotCallOverseasR Report Trouble

211 speedCall Report Trouble

212 cannotCall911 Report Trouble

213 cannotCall700 Report Trouble

214 cannotCall800_888 Report Trouble

215 cannotCall900 Report Trouble

216 cannotCallDA Report Trouble

217 cannotCallIntra_LataToll Report Trouble

300 canNotBeCalledGroup Report Trouble

301 canNotBeCalled Report Trouble

302 canNotBeCalledBusy Report Trouble

303 doNotGetCalled Report Trouble

304 canNotTripRing Report Trouble

305 falseRing Report Trouble
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306 doNotAnswer Report Trouble

307 reachRecording Report Trouble

308 canNotRaiseAStation Report Trouble

309 canNotRaiseADrop Report Trouble

310 canNotRaiseACircuitLocation Report Trouble

311 ringNoAnswer Report Trouble

312 reorder Report Trouble

313 alwaysBusy Report Trouble

314 bellDoesNotRing Report Trouble

315 bellDoesNotRing2 Report Trouble

316 bellRingsCanNotAnswer Report Trouble

317 bellRingsAfterAnswer Report Trouble

318 noRingNoAnswer Report Trouble

319 otherRingTrouble Report Trouble

320 receivesCallsForWrongNumber Report Trouble

321 recordingOnLine Report Trouble

322 ringsThenGoesBusy Report Trouble

400 canNotBeHeardGroup Report Trouble

401 canNotBeHeard Report Trouble

402 canNotHear Report Trouble

403 fading Report Trouble

404 distant Report Trouble

500 reachesWrongNumberGroup Report Trouble

501 wrongNumber Report Trouble

502 wrongPSAPNumber Report Trouble

600 circuitOperationGroup Report Trouble

601 open Report Trouble

602 falseDisconnect Report Trouble

603 grounded Report Trouble

604 canNotBeSignalled Report Trouble
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605 canNotSignal Report Trouble

606 permanentSignal Report Trouble

607 improperSupervision Report Trouble

608 supervision Report Trouble

609 canNotMeet Report Trouble

610 canNotReleaseCircuit Report Trouble

611 hungUp Report Trouble

612 noWinkStart Report Trouble

613 noSF Report Trouble

614 lowSF Report Trouble

615 noContinuity Report Trouble

616 cutCable Report Trouble

617 openToDEMARC Report Trouble

618 noRingGenerator Report Trouble

619 badERL Report Trouble

620 echo Report Trouble

621 hollow Report Trouble

622 circuitDead Report Trouble

623 circuitDown Report Trouble

624 failingCircuit Report Trouble

625 noSignal Report Trouble

626 seizureOnCircuit Report Trouble

627 lossEPSCSorSwitchedServices Report Trouble

628 monitorCircuit Request Testing

629 newServiceNotWorking Report Trouble

630 openEPSCSorSwitchedServices Report Trouble

631 otherVoiceDescribeAdditInfo Report Trouble

632 trunkBlockedFarend Report Trouble

633 badBalance Report Trouble

634 highRateIncompleteIncoming Report Trouble
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635 outgoingFailureAfterWink Report Trouble

700 cutOffsGroup Report Trouble

701 cutsOff Report Trouble

800 noiseProblemGroup Report Trouble

801 intermittentNoise Report Trouble

802 noisy Report Trouble

803 foreignNoise Report Trouble

804 clipping Report Trouble

805 crossTalk Report Trouble

806 staticOnLine Report Trouble

807 groundHum Report Trouble

808 hearsOtherOnLine Report Trouble

809 humOnLine Report Trouble

810 clicking Report Trouble

811 noiseEPSCSorSwitchedServices Report Trouble

900 levelTroublesGroup Report Trouble

901 lowLevels Report Trouble

902 highLevels Report Trouble

903 longLevels Report Trouble

904 hotLevels Report Trouble

905 highEndRollOff Report Trouble

906 lowEndRollOff Report Trouble

907 needsEqualized Report Trouble

908 lineLoss Report Trouble

909 doesNotPassFreqResponse Report Trouble

910 levelsOutOfLimits Report Trouble

1000 miscellaneousTroubleGroup Report Trouble

1001 hiCapDown Report Trouble

1002 carrierDown Report Trouble

1003 biPolarViolations Report Trouble
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1004 frameErrorsHiCap Report Trouble

1005 outOfFrame Report Trouble

1006 lossOfSync Report Trouble

1007 frameSlips Report Trouble

1008 noLoopback Report Trouble

1009 canNotLoopbackDEMARC Report Trouble

1010 recordingOnCircuit Report Trouble

1011 linesNeedTagging Report Trouble

1012 outwatsRingingIn Report Trouble

1013 remoteAccess Report Trouble

1014 other Report Trouble

1015 alarm Report Trouble

1016 multipleShortDurationHit Report Trouble

1017 frameErrors Report Trouble

1018 facilityAlarm Report Trouble

1019 softwareGroupAlarm Report Trouble

1020 dChannelDown Report Trouble

1021 degradationOfT1_5 Report Trouble

1022 networkFailure Report Trouble

1023 noPSAPInfo Report Trouble

1100 memoryServiceProblemGroup Report Trouble

1101 pICTrouble Report Trouble

1102 callTransferProblem Report Trouble

1103 callWaitingProblem Report Trouble

1104 customCallFeature Report Trouble

1105 threeWayCalling Report Trouble

1106 callTraceNotWorking Report Trouble

1107 callTraceBlockNotWorking Report Trouble

1108 repeatDialNotWorking Report Trouble

1109 repeatDialBlockNotWorking Report Trouble
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1110 callReturnNotWorking Report Trouble

1111 callReturnBlockNotWorking Report Trouble

1112 callerIdentificationNotWork Report Trouble

1113 callBlockingNotWorking Report Trouble

1114 voiceMessagingServiceProblem Report Trouble

1115 callForwardingNotWorking Report Trouble

1116 callForwardingBusyLineNotWor
king

Report Trouble

1117 callForwardingNoAnswerNotWor
king

Report Trouble

1118 huntingNotWorking Report Trouble

1119 selectiveCallForwardingNotWork
ing

Report Trouble

1120 cannotSetupUniqueRingID Report Trouble

1121 callerIDBlockNotWorkingPerLin
e

Report Trouble

1122 callerIDBlockNotWorkingPerCall Report Trouble

1123 cannotRemoveBlockingOnASingl
eCall

Report Trouble

1124 remoteCallForwarding Report Trouble

1125 commonBlockCentrexProblems Report Trouble

1126 incorrctCallerID Report Trouble

1200 dataTroubleGroup Report Trouble

1201 canNotReceiveData Report Trouble

1202 canNotSendData Report Trouble

1203 canNotTransmitCanNotReceive Report Trouble

1204 noReceive Report Trouble

1205 noResponse Report Trouble

1206 delay Report Trouble

1207 impulseNoise Report Trouble

1208 phaseJitter Report Trouble

1209 harmonicDistortion Report Trouble
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1210 highDistortion Report Trouble

1211 noDataLoopback Report Trouble

1212 noCarrier Report Trouble

1213 notPolling Report Trouble

1214 dataFramingErrors Report Trouble

1215 dropOuts Report Trouble

1216 hits Report Trouble

1217 noAnswerBack Report Trouble

1218 streamer Report Trouble

1219 outOfSpecification Report Trouble

1220 canNotRunToCSU Report Trouble

1221 canNotTunToOSU Report Trouble

1222 deadDataCurcuit Report Trouble

1223 circuitInLoopback Report Trouble

1224 errors Report Trouble

1225 garbledData Report Trouble

1226 invalidData Report Trouble

1227 crossModulation Report Trouble

1228 slowResponse Report Trouble

1229 otherDataDescribeAdditInfo Report Trouble

1230 gettingAllOnes Report Trouble

1231 slip Report Trouble

1300 stationTroubleGroup Report Trouble

1301 voiceEquipment Report Trouble

1302 dataEquipment Report Trouble

1303 videoEquipment Report Trouble

1304 otherEquipment Report Trouble

1305 stationWiring Report Trouble

1400 physicalTroubleGroup Report Trouble

1401 lightBurnedOut Report Trouble
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1402 dataset Report Trouble

1403 ttySet Report Trouble

1404 highSpeedPrinter Report Trouble

1405 aNI Report Trouble

1406 aLI Report Trouble

1407 canNotActivatePC Report Trouble

1408 modem Report Trouble

1409 cathodeRayTube Report Trouble

1410 looseJack Report Trouble

1411 offHook Report Trouble

1412 physicalProblem Report Trouble

1413 processerDead Report Trouble

1414 wiringProblem Report Trouble

1415 wireBrokeSetBrokePoleDown Report Trouble

1416 noRegister Report Trouble

1417 stuckSender Report Trouble

1418 otherStationTrouble Report Trouble

1500 otherCaseGroup Report Trouble

1501 callTransferProblem Report Trouble

1502 callWaitingProblem Report Trouble

1503 customCallFeatureDoNotWork Report Trouble

1504 information Provide Info

1505 threeWayCallingProblem Report Trouble

1506 orderWork Report Trouble

1507 releaseCktRequestedByIC Release Circuit

1508 releaseCktRequestedByEC Release Circuit

1509 releaseFacilityRequestedByIC Release Circuit

1510 releaseFacilityRequestedByEC Release Circuit

1511 requestForRoutine Report Trouble

1512 release Release Circuit
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1513 requestDispatch Report Trouble

1514 requestMonitorOfCircuit Report Trouble

1515 routineTestFailure Report Trouble

1516 lostTimerReport Report Trouble

1517 historicalReports Report Trouble

1518 switchOrTrunkRelated Report Trouble

1519 requestTestAssist Request Testing

1520 analogTestLine Report Trouble

1521 digitalTestLine Report Trouble

1522 manualInterventionRequested Report Trouble

1600 recovery Provide Info

1601 recoveryReport Provide Info

1700 switchedNetworkProblemGroup Report Trouble

1701 aNITimeOut Report Trouble

1702 extraDigit Report Trouble

1703 extraPulse Report Trouble

1704 falseKeyPulse Report Trouble

1705 misplacedStartPulse Report Trouble

1706 mutatedDigit Report Trouble

1707 noKeyPulse Report Trouble

1708 partialDialTimeout Report Trouble

1709 signalNetworkFailureIncoming Report Trouble

1710 stationGrpDesignatiDigitFail Report Trouble

1711 aNIProblem Report Trouble

1712 OSPSEqualAccessSignaling Report Trouble

1713 missingANI Report Trouble

1714 vacantCodeAnnouncement Report Trouble

1715 invalidDigit Report Trouble

1716 highandWet Report Trouble

1800 payPhoneProblemsGroup Report Trouble
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1801 noCoinReturn Report Trouble

1802 coinStuck Report Trouble

1803 cannotDepositCoin Report Trouble

1804 coinsFallThrough Report Trouble

1805 coinsDoNotRegister Report Trouble

1806 payPhoneDamage Report Trouble

9998 undefinedType Undefined

9999 genericWFA Report Trouble

Appendix  E   Trouble Type Codes and Descriptions

Trouble Code Trouble Description Action
100 noDialToneGroup Report Trouble
101 noDialTone Report Trouble
102 slowDialTone Report Trouble
103 circuitDead Report Trouble
200 canNotCallOutGroup Report Trouble
201 canNotCallOut Report Trouble
203 canNotBreakDialTone Report Trouble
204 dialToneAfterDialing Report Trouble
205 highAndDry Report Trouble
206 canNotRaise Report Trouble
207 allAccessBusy Report Trouble
208 canNotCallOut2 Report Trouble
209 canNotCallLongDistance Report Trouble
210 canNotCallOverseasR Report Trouble
211 speedCall Report Trouble
212 cannotCall911 Report Trouble
213 cannotCall700 Report Trouble
214 cannotCall800_888 Report Trouble
215 cannotCall900 Report Trouble
216 cannotCallDA Report Trouble
217 cannotCallIntra_LataToll Report Trouble
300 canNotBeCalledGroup Report Trouble
301 canNotBeCalled Report Trouble
302 canNotBeCalledBusy Report Trouble
303 doNotGetCalled Report Trouble
304 canNotTripRing Report Trouble
305 falseRing Report Trouble
306 doNotAnswer Report Trouble
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307 reachRecording Report Trouble
308 canNotRaiseAStation Report Trouble
309 canNotRaiseADrop Report Trouble
310 canNotRaiseACircuitLocation Report Trouble
311 ringNoAnswer Report Trouble
312 reorder Report Trouble
313 alwaysBusy Report Trouble
314 bellDoesNotRing Report Trouble
315 bellDoesNotRing2 Report Trouble
316 bellRingsCanNotAnswer Report Trouble
317 bellRingsAfterAnswer Report Trouble
318 noRingNoAnswer Report Trouble
319 otherRingTrouble Report Trouble
320 receivesCallsForWrongNumber Report Trouble
321 recordingOnLine Report Trouble
322 ringsThenGoesBusy Report Trouble
400 canNotBeHeardGroup Report Trouble
401 canNotBeHeard Report Trouble
402 canNotHear Report Trouble
403 fading Report Trouble
404 distant Report Trouble
500 reachesWrongNumberGroup Report Trouble
501 wrongNumber Report Trouble
502 wrongPSAPNumber Report Trouble
600 circuitOperationGroup Report Trouble
601 open Report Trouble
602 falseDisconnect Report Trouble
603 grounded Report Trouble
604 canNotBeSignalled Report Trouble
605 canNotSignal Report Trouble
606 permanentSignal Report Trouble
607 improperSupervision Report Trouble
608 supervision Report Trouble
609 canNotMeet Report Trouble
610 canNotReleaseCircuit Report Trouble
611 hungUp Report Trouble
612 noWinkStart Report Trouble
613 noSF Report Trouble
614 lowSF Report Trouble
615 noContinuity Report Trouble
616 cutCable Report Trouble
617 openToDEMARC Report Trouble
618 noRingGenerator Report Trouble
619 badERL Report Trouble
620 echo Report Trouble
621 hollow Report Trouble
622 circuitDead Report Trouble
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623 circuitDown Report Trouble
624 failingCircuit Report Trouble
625 noSignal Report Trouble
626 seizureOnCircuit Report Trouble
627 lossEPSCSorSwitchedServices Report Trouble
628 monitorCircuit Request Testing
629 newServiceNotWorking Report Trouble
630 openEPSCSorSwitchedServices Report Trouble
631 otherVoiceDescribeAdditInfo Report Trouble
632 trunkBlockedFarend Report Trouble
633 badBalance Report Trouble
634 highRateIncompleteIncoming Report Trouble
635 outgoingFailureAfterWink Report Trouble
700 cutOffsGroup Report Trouble
701 cutsOff Report Trouble
800 noiseProblemGroup Report Trouble
801 intermittentNoise Report Trouble
802 noisy Report Trouble
803 foreignNoise Report Trouble
804 clipping Report Trouble
805 crossTalk Report Trouble
806 staticOnLine Report Trouble
807 groundHum Report Trouble
808 hearsOtherOnLine Report Trouble
809 humOnLine Report Trouble
810 clicking Report Trouble
811 noiseEPSCSorSwitchedServices Report Trouble
900 levelTroublesGroup Report Trouble
901 lowLevels Report Trouble
902 highLevels Report Trouble
903 longLevels Report Trouble
904 hotLevels Report Trouble
905 highEndRollOff Report Trouble
906 lowEndRollOff Report Trouble
907 needsEqualized Report Trouble
908 lineLoss Report Trouble
909 doesNotPassFreqResponse Report Trouble
910 levelsOutOfLimits Report Trouble
1000 miscellaneousTroubleGroup Report Trouble
1001 hiCapDown Report Trouble
1002 carrierDown Report Trouble
1003 biPolarViolations Report Trouble
1004 frameErrorsHiCap Report Trouble
1005 outOfFrame Report Trouble
1006 lossOfSync Report Trouble
1007 frameSlips Report Trouble
1008 noLoopback Report Trouble
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1009 canNotLoopbackDEMARC Report Trouble
1010 recordingOnCircuit Report Trouble
1011 linesNeedTagging Report Trouble
1012 outwatsRingingIn Report Trouble
1013 remoteAccess Report Trouble
1014 other Report Trouble
1015 alarm Report Trouble
1016 multipleShortDurationHit Report Trouble
1017 frameErrors Report Trouble
1018 facilityAlarm Report Trouble
1019 softwareGroupAlarm Report Trouble
1020 dChannelDown Report Trouble
1021 degradationOfT1_5 Report Trouble
1022 networkFailure Report Trouble
1023 noPSAPInfo Report Trouble
1100 memoryServiceProblemGroup Report Trouble
1101 pICTrouble Report Trouble
1102 callTransferProblem Report Trouble
1103 callWaitingProblem Report Trouble
1104 customCallFeature Report Trouble
1105 threeWayCalling Report Trouble
1106 callTraceNotWorking Report Trouble
1107 callTraceBlockNotWorking Report Trouble
1108 repeatDialNotWorking Report Trouble
1109 repeatDialBlockNotWorking Report Trouble
1110 callReturnNotWorking Report Trouble
1111 callReturnBlockNotWorking Report Trouble
1112 callerIdentificationNotWork Report Trouble
1113 callBlockingNotWorking Report Trouble
1114 voiceMessagingServiceProblem Report Trouble
1115 callForwardingNotWorking Report Trouble
1116 callForwardingBusyLineNotWorking Report Trouble
1117 callForwardingNoAnswerNotWorking Report Trouble
1118 huntingNotWorking Report Trouble
1119 selectiveCallForwardingNotWorking Report Trouble
1120 cannotSetupUniqueRingID Report Trouble
1121 callerIDBlockNotWorkingPerLIne Report Trouble
1122 callerIDBlockNotWorkingPerCall Report Trouble
1123 cannotRemoveBlockingOnASingleCall Report Trouble
1124 remoteCallForwarding Report Trouble
1125 commonBlockCentrexProblems Report Trouble
1126 incorrectCallerID Report Trouble
1200 dataTroubleGroup Report Trouble
1201 canNotReceiveData Report Trouble
1202 canNotSendData Report Trouble
1203 canNotTransmitCanNotReceive Report Trouble
1204 noReceive Report Trouble
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1205 noResponse Report Trouble
1206 delay Report Trouble
1207 impulseNoise Report Trouble
1208 phaseJitter Report Trouble
1209 harmonicDistortion Report Trouble
1210 highDistortion Report Trouble
1211 noDataLoopback Report Trouble
1212 noCarrier Report Trouble
1213 notPolling Report Trouble
1214 dataFramingErrors Report Trouble
1215 dropOuts Report Trouble
1216 hits Report Trouble
1217 noAnswerBack Report Trouble
1218 streamer Report Trouble
1219 outOfSpecification Report Trouble
1220 canNotRunToCSU Report Trouble
1221 canNotTunToOSU Report Trouble
1222 deadDataCurcuit Report Trouble
1223 circuitInLoopback Report Trouble
1224 errors Report Trouble
1225 garbledData Report Trouble
1226 invalidData Report Trouble
1227 crossModulation Report Trouble
1228 slowResponse Report Trouble
1229 otherDataDescribeAdditInfo Report Trouble
1230 gettingAllOnes Report Trouble
1231 slip Report Trouble
1300 stationTroubleGroup Report Trouble
1301 voiceEquipment Report Trouble
1302 dataEquipment Report Trouble
1303 videoEquipment Report Trouble
1304 otherEquipment Report Trouble
1305 stationWiring Report Trouble
1400 physicalTroubleGroup Report Trouble
1401 lightBurnedOut Report Trouble
1402 dataset Report Trouble
1403 ttySet Report Trouble
1404 highSpeedPrinter Report Trouble
1405 aNI Report Trouble
1406 aLI Report Trouble
1407 canNotActivatePC Report Trouble
1408 modem Report Trouble
1409 cathodeRayTube Report Trouble
1410 looseJack Report Trouble
1411 offHook Report Trouble
1412 physicalProblem Report Trouble
1413 processerDead Report Trouble
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1414 wiringProblem Report Trouble
1415 wireBrokeSetBrokePoleDown Report Trouble
1416 noRegister Report Trouble
1417 stuckSender Report Trouble
1418 otherStationTrouble Report Trouble
1500 otherCaseGroup Report Trouble
1501 callTransferProblem Report Trouble
1502 callWaitingProblem Report Trouble
1503 customCallFeatureDoNotWork Report Trouble
1504 information Provide Info
1505 threeWayCallingProblem Report Trouble
1506 orderWork Report Trouble
1507 releaseCktRequestedByIC Release Circuit
1508 releaseCktRequestedByEC Release Circuit
1509 releaseFacilityRequestedByIC Release Circuit
1510 releaseFacilityRequestedByEC Release Circuit
1511 requestForRoutine Report Trouble
1512 release Release Circuit
1513 requestDispatch Report Trouble
1514 requestMonitorOfCircuit Report Trouble
1515 routineTestFailure Report Trouble
1516 lostTimerReport Report Trouble
1517 historicalReports Report Trouble
1518 switchOrTrunkRelated Report Trouble
1519 requestTestAssist Request Testing
1520 analogTestLine Report Trouble
1521 digitalTestLine Report Trouble
1522 manualInterventionRequested Report Trouble
1600 recovery Provide Info
1601 recoveryReport Provide Info
1700 switchedNetworkProblemGroup Report Trouble
1701 aNITimeOut Report Trouble
1702 extraDigit Report Trouble
1703 extraPulse Report Trouble
1704 falseKeyPulse Report Trouble
1705 misplacedStartPulse Report Trouble
1706 mutatedDigit Report Trouble
1707 noKeyPulse Report Trouble
1708 partialDialTimeout Report Trouble
1709 signalNetworkFailureIncoming Report Trouble
1710 stationGrpDesignatiDigitFail Report Trouble
1711 aNIProblem Report Trouble
1712 OSPSEqualAccessSignaling Report Trouble
1713 missingANI Report Trouble
1714 vacantCodeAnnouncement Report Trouble
1715 invalidDigit Report Trouble
1716 highandWet Report Trouble
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1800 payPhoneProblemsGroup Report Trouble
1801 noCoinReturn Report Trouble
1802 coinStuck Report Trouble
1803 cannotDepositCoin Report Trouble
1804 coinsFallThrough Report Trouble
1805 coinsDoNotRegister Report Trouble
1806 payPhoneDamage Report Trouble
9998 undefinedType Undefined
9999 genericWFA Report Trouble
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Appendix  F   Circuit ID Status Descriptions

AP Analyze - Available for Pickup
APP Analyze - Automatic Process Pending - This trouble report is on the available work list

for the automated test system to test the service and report back to the SWB/PB/NB test
center

AT Analyze - Pending Test Request - For POTS, indicates that a MLT test has been
requested

ATC Analyze - Test Request Completed - For POTS, indicates that the MLT test has been
completed

ATX Testing Expired - For POTS, indicates that the MLT test request timer has expired and
the trouble report is available for the test center technician to check status on the test
request

CAN Report Is Canceled - The trouble report has been canceled and no activity is being
performed on the circuit.

CLD Report Is Closed - The trouble report has been closed out by the SWB/PB/NB test center,
and service has been restored

D Disconnected
DM Delayed Maintenance - The trouble report has been placed in delayed maintenance

stating that the repair process has been delayed. This should be at the concurrence of the
customer

GRP Grouped - This trouble report has been grouped with other trouble reports due to a
common failure that is affecting all of the trouble reports. (i.e., cable cut)

HCC Retesting Service
HCX Dispatched To C.O. - The central office hand 0ff timer has expired. The trouble report is

available for the test center technician to check the status of the hand off to the facility
organization.

HDC Dispatched To C.O. .: The SWB/PB/NB test center has determined that a technician in
the Central Office is needed to work on the trouble. The trouble report has been handed
off to the Central Office

HDCF Dispatched In - Deferred - The SWB/PB/NB central office has deferred working on this
trouble report at this time.

HDCJ Dispatched In - Jeopardy The trouble report has been placed in Jeopardy by the central
office and the repair cannot be completed at this time.

HDCL Dispatched In - Craft Loaded - The trouble report was handed off the central office and a
technician is currently working on the trouble report.

HDCP Dispatched In - Pending Load - The trouble report was handed off to the central office
and is waiting to be loaded to a central office technician.

HDCR Dispatched In - Referred to WFA/DI Location The trouble report was handed off to a
central office who has referred the trouble report to another central office to work on
repairing the trouble.

HDCV Dispatched In - Management Review - The trouble report was handed off to a central
office and the technician has referred the trouble to a management person for review.

HDD Dispatched Out - The trouble report was handed off to the SWB/PB/NB outside repair
organization in order to get a repairman dispatched to work on the facilities serving the
customer location, the Network Channel Terminating Equipment at the customer
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premise. This includes all SWB/PB/NB equipment up to and including the Network
Interface

HDDA Dispatched Out – Pre-assigned - The trouble report was handed off to the SWB/PB/NB
outside repair organization and has been placed on a technician’s worklist but the
technician has not begun to work on the trouble report as of this time

HDDJ Dispatched Out - Jeopardy - The trouble report was handed off to the SWB/PB/NB
outside repair organization and has been placed in jeopardy by the technician indicating
that repairs cannot be completed at this time

HDDL Dispatched Out - Craft Loaded - The trouble report was handed off to the SWB/PB/NB
outside repair organization and a technician is currently working on repairing the trouble

HDDP Dispatched Out - Pending Load - The trouble report was handed off to the SWB/PB/NB
outside repair organization and is waiting to be placed on the worklist of an outside
repairman

HDDS Dispatched Out - Pending Price/Logging - The trouble report was handed off to the
SWB/PB/NB outside repair organization and is waiting to be priced out (estimate of time
required to repair)

HDF Dispatched Out - Facility - The trouble report was handed off to the SWB/PB/NB outside
repair organization in order to get a repairman dispatched to work on the facilities serving
the customer location. The Network Channel Terminating Equipment at the customer
premise. This includes all SWB/PB/NB equipment up to and including the Network
interface.

HDX Dispatched Out - The outside repair organization hand-off timer has expired. The trouble
report is available for the test center technician to check the status of the outside repair
handoff

HFX Dispatched To Cable - The facility organization hand off timer has expired. The trouble
report is available for the test center technician to check the status of the and off to the
facility organization.

HI Historic
HLD Report On Hold - The trouble report has been place don hold by the SWB/PB/NB test

center and repair efforts have stopped at this time.
IE Report In Effect
IP Analyze - Craft Loaded - This trouble report is currently being worked on by a technician

in the SWB/PB/NB test center.
NA No Access - The trouble report has been placed in no access. This should be at the

concurrence of the customer. If premise access is needed and is not available or
additional information is needed from the customer who is not available, the trouble
report may be placed in no access. If the customer is not available to verify that repairs
have been completed, the trouble report can be placed in no access awaiting a call back
from the customer.

NAP Analyze - Not Available for Pickup -
NM Service ID Not Found -
P Report is Pending.
PP Analyze - Pending Craft - This trouble report is on the available work list in the

SWB/PB/NB test center and will be worked on when personnel are available.
REF Referred Out - The trouble report has been referred to another telephone company or to

another SWB/PB/NB test center to initiate repairs.
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RFX Referred Out - The hand-off to another telephone company or another SWB/PB/NB test
center timer has expired. The trouble report is available for the test center technician to
check the status of the hand off to the other organization.

RPV Repair Verified.
RPVF Verify - Dispatch Facility - Work on the trouble report has been completed by the outside

facility repair technician and the trouble is on the available work list in the SWB/PB/NB
test center. The test center technician needs to verify that the repairs are complete and
then contact the customer to close out the trouble report.

RPVI Verify - Dispatch In - Work on this trouble report has been completed by the central
office technician and the trouble report is on the available work list in the SWB/PB/NB
test center. The test center technician needs to verify that the repairs are complete and
then contact the customer to close out the trouble report.

RPVO Verify - Dispatch Out - Work on the trouble report has been completed by the outside
repair technician and the trouble report is on the available work list in the SWB/PB/NB
test center. The test center technician needs to verify that the repairs are complete and
then contact the customer to close out the trouble report.

RPVR Verify - Referred - Work on the trouble report has been completed by the other telephone
company or SWB/PB/NB test center that the trouble report was referred to and the
trouble report is on the available work list in the SWB/PB/NB test center. The test center
technician needs to verify that the repairs are complete and then contact the customer to
close out the trouble report.

RST Service is Restored-The repairs have been completed and the customer has been advised
that the service was fixed.

RSTN Restored Customer Not Advised - The repairs have been completed but the customer was
not available to advise that the service was fixed.

VTK Verify - Test OK –
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Appendix  G   Circuit ID Log Functions

CAN Canceled
CCL Dispatched In
CLD Closed
CUS Remark for customer to see
DME Delayed Maintenance End
DMS Delayed Maintenance Start
HDF Dispatch out-facility
NAE No Access End
NAS No Access Start
RST Restored Cust Advised
SDD Dispatched Out
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